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ABSTRAKT 

Diplomová práce se zabývá zpracováním souboru tematických map města 

Benešov a jeho okolí. Textová část této práce obsahuje krátký popis 

mapovaného území a stručnou historii města Benešov. Přehledně popisuje 

tematickou kartografii, zásady tvorby tematických map i praktický postup 

vytváření tematických map v software ArcGIS. Kromě standardních dat jsou 

díky nástrojům ArcGIS zpracovány vlastní analýzy. Obrazová část této práce 

obsahuje čtrnáct mapových listů, které zobrazují informace o městě Benešov, 

jeho blízkém i vzdálenějším okolí a o lidech, kteří zde žijí. 

KLÍČOVÁ SLOVA 

Benešov, tematické mapy, tematická kartografie, ArcGIS, ArcMap 

 

ABSTRACT  

The diploma thesis deals with the thematic map set processing of the town 

Benešov and its surroundings. The text part contains a short description of 

the mapped area and a concise history of Benešov. It gives an overview of the 

thematic cartography, describes creating principles of thematic maps and a 

practical creation process in the software ArcGIS. Besides standard data, 

there are also processed other analysis in ArcGIS. The following picture part 

of this thesis contains fourteen map sheets showing information about 

Benešov, its near and distant surroundings and about the people who live 

there. 
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Úvod 

Benešov je místem, ve kterém jsem vyrůstala. Navštěvovala jsem zde 

mateřskou, základní i střední školu a jednou se sem možná vrátím.  

Touto prací bych ráda zpracovala nejrůznější data o městě Benešov, a o jeho 

okolí. A to právě formou tematických map, které jsou názorné a snadno 

uchopitelné. Zobrazením tematických a statistických dat do mapy mohou na 

první pohled vyniknout informace, které z tabulky nebo textu nemusí být tak 

snadno čitelné.  

Chtěla bych skrze tuto práci město Benešov sama lépe poznat a následně bych 

chtěla, aby tato práce přiblížila město také lidem, kteří v něm žijí a nejen jim. 

Výsledný soubor tematických map rozšířený o další informace a grafy by měl 

být v příštím roce prezentován formou výstavy pro veřejnost ve výstavní síni 

města Benešov. 

Celá práce je pro lepší srozumitelnost rozdělena do několika kapitol.  

V první kapitole je zmínka o městě a okrese Benešov, včetně stručné historie 

města.  

Druhá kapitola podrobně popisuje teorii tematické kartografie – kompozici 

map, zásady tvorby tematických map, vyjadřovací prostředky a metody 

tematické kartografie. 

Kapitola třetí hovoří o pozadí vzniku tematických map, o kartografickém 

zobrazení, ve kterém jsou mapy vytvořeny, o zdrojích použitých dat 

a o software použitém pro zpracování map. 

Kapitola čtvrtá popisuje vlastní zpracování souboru map, jeho koncepci 

a tvorbu jednotlivých map v prostředí ArcGIS. 

Pátá kapitola shrnuje informace o vytvořených mapových listech. 
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Rešerše 

Prvotní inspirací pro tvorbu této práce mi byla výstava „Znáte Prahu? Město v 

mapách, grafech a číslech“. Tato výstava byla vytvořena Institutem plánování 

a rozvoje hlavního města Prahy, jmenovitě Kateřinou Hynkovou, Helenou 

Kynclovou a Eliška Kyzlíkovou, na grafice celé výstavy pak pracoval Roman 

Černohous. Výstava je grafickou prezentací dat, která sbírá a vyhodnocuje 

Sekce prostorových informací Institutu plánování a rozvoje Prahy. K této 

výstavě byla vytištěna stejnojmenná brožura. [Znáte Prahu? Město v mapách, 

grafech a číslech, Institut plánování a rozvoje hlavního města Prahy, 2015, 

ISBN: 978-80-87931-52-3] Expozice byla vystavena koncem roku 2015 v Sále 

architektů na Staroměstské radnici a zobrazovala, jak její název napovídá, 

informace o našem hlavním městě a jeho obyvatelích formou map, grafů a 

čísel, což mi přišlo velmi zajímavé a ráda bych tímto způsobem přiblížila město 

Benešov jeho obyvatelům a nejen jim. „Znáte Prahu?“ je komplexně spíše 

informační grafikou než kartografickým dílem, proto jsem odtud čerpala více 

myšlenky a náměty jednotlivých map než grafické provedení. 

Dalším dílem, ze kterého jsem čerpala náměty na témata jednotlivých map je 

diplomní projekt Filipa Foglara z roku 2016 s názvem Metropolitní region. 

[FOGLAR, Filip. Metropolitní region, dostupné z: http://architekt-foglar.cz/ 

urbanisticka-koncepce-metropolitniho-regionu/] Tento projekt řeší 

urbanistickou koncepci Metropolitního regionu, zároveň tento region definuje 

a vymezuje jeho území, a dále navrhuje koncepci rozvoje krajiny a sídel 

Metropolitního regionu. Výzkumná část tohoto projektu obsahuje několik 

map, které znázorňují statistiky přilehlých měst ovlivněné blízkostí hlavního 

města a vzájemné vztahy Prahy s těmito okolními sídly. Město Benešov se 

nachází těsně za hranicí tohoto Metropolitního regionu. 

Přestože město Benešov i jeho historii poměrně dobře znám, bylo pro tuto 

práci nezbytné data podložit odbornou literaturou o těchto faktech. Nejvíce mi 

v této oblasti byla užitečná kniha napsaná Evou Procházkovou – Město 

Benešov. [PROCHÁZKOVÁ, Eva. Benešov. Benešov: Město Benešov, 1998. 

ISBN 80-238-2752-9] Tato kniha obsahuje podrobně sepsanou historii města 

Benešov i blízkého zámku Konopiště a rodů, kterým město v minulosti patřilo. 

Za velmi užitečné při tvorbě této práce považuji knihy věnované tematické 

kartografii. Zejména knihu s názvem Metody tematické kartografie: 

vizualizace prostorových jevů, od autorů Víta Voženílka a Jaromíra Kaňoka. 

[VOŽENÍLEK, Vít a Jaromír KAŇOK. Metody tematické kartografie: vizualizace 

prostorových jevů. Olomouc: Univerzita Palackého v Olomouci pro katedru 

geoinformatiky, 2011. ISBN 978-80-244-2790-4] Kniha obsahuje podrobný 

přehled vyjadřovacích prostředků a jejich vlastností, metod tematické 

kartografie i kompozičních prvků, ale také základní pravidla tvorby a využití 

tematických map. Všechna témata jsou systematicky uspořádána do 
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jednotlivých kapitol. Podle koncepce tematické kartografie v této knize jsem 

strukturovala teoretickou část této práce. 

Neméně důležitým zdrojem teoretických znalostí tematické kartografie mi byla 

kniha Topografická a tematická kartografie od autorů Bohuslava Veverky a 

Růženy Zimové. [VEVERKA, Bohuslav a Růžena ZIMOVÁ. Topografická a 

tematická kartografie. V Praze: České vysoké učení technické, 2008. ISBN 

978-80-01-04157-4.]  

Zatímco při samotné tvorbě mapových listů mi byl hlavní podporou e-

learningový portál o tvorbě map, vytvořený Tomášem Janatou, ve spolupráci 

s J. Cajthamlem a P. Seemannem. [KARTOGRAFIE: e-learningový portál o 

tvorbě map, dostupný z: http://gisserver.fsv.cvut.cz/kartografie/] Webové 

stránky „Kartografie“ jsou pomocným materiálem pro výuku digitální 

kartografie zaměřené na práci v software ArcGIS a OCAD. Kromě postupů pro 

práci ve jmenovaných programech jsou zde podrobně popsány zásady pro 

tvorbu map a příklady chyb, jakých by se tvůrci map neměli dopouštět. 

Práce s barvami na vytvořených mapových listech byla ovlivněna bakalářskou 

prací Andrey Hohnové o tvorbě barevných stupnic podle stylu map 

z Univerzity Palackého v Olomouci z roku 2016. [HOHNOVÁ, Andrea. Tvorba 

barevných stupnic podle stylu map, dostupné z: 

http://www.geoinformatics.upol.cz/dprace/bakalarske/hohnova16/index.p

hp] A. Hohnová se v této práci zabývala barvami a jejich použitím v kartografii 

a vytvořila díky této bakalářské práci barevné stupnice roztříděné podle stylu 

map. 

Podstatným zdrojem odborné literatury z oblasti GIS pro mne byly oficiální 

stránky Esri ArcGIS for Desktop help 10.3, dostupné z: 

http://desktop.arcgis.com/en/arcmap/10.3/main/guide-books/about-

arcgis-for-desktop-extensions.htm. 
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Cíl a metodika práce 

Cílem této práce je zpracovat formou tematických map statistická a další 

tematická data o městě Benešov, jeho obyvatelích a okolí tohoto města.  

Kromě samotného souboru map je cílem této práce vznik přehledu tematické 

kartografie a tvorby tematických map obecně, ale také popis praktického 

postupu při tvorbě tematických map v prostředí ArcMap. 

Prvním krokem k vytvoření této práce byla důkladná rešerše literatury i 

internetových zdrojů. Získané poznatky byly využity nejen při psaní textu této 

práce, ale i při samotné tvorbě tematických map. 

Dalším důležitým úkolem bylo shromáždit geografická, tematická a statistická 

data pro následnou tvorbu tematických map. Geografickým základem 

mapových listů jsou především vrstvy budov, městských sídel, pozemních 

komunikací, vodních ploch a dělení územních celků. Všechna tato data byla 

stažena z veřejně dostupných internetových zdrojů. Tematická a statistická 

data byla také dohledána na internetu nebo poskytnuta ze zdrojů fakulty. 

Anebo byla v případě nedostatku informací zjištěna v rámci vlastního šetření, 

které probíhalo přímo v terénu nebo analýzou ortofotosnímků a 

panoramatických scén dostupných on-line.  

Vlastní zpracování tematických map probíhalo v prostředí ArcMap programu 

ArcGIS for Desktop 10.3, které umožňuje základní i složitější úpravu 

geografických dat, ale také kartografické zpracování tematických a 

statistických údajů i výslednou tvorbu mapové kompozice. Pro jednotlivé 

mapové listy byly vytvořeny samostatné mapové dokumenty ve formátu MXD. 

Vytvořené mapové listy byly následně exportovány do formátu PDF s 

rozlišením 300 DPI, v barevném modelu CMYK. A díky vedoucímu této práce 

a fakultnímu plotru na závěr i vytištěny. 

Některé výpočty a úpravy dat byly provedeny v prostředí Microsoft Excel 

software MS Office 2013 od společnosti Microsoft. V textovém procesoru 

stejného programu, v Microsoft Word byl sestaven text této práce. 
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1 Benešov 

Benešov nese své jméno podle rodu Benešoviců, který jej založil. Název tohoto 

rodu je odvozen od často se opakujícího křestního jména Beneš, které je 

staročeskou obdobou jména Benedikt. 

1.1 Město Benešov 

Město Benešov leží asi 40 km jižně od hlavního města Prahy a žije v něm 16,5 

tisíce obyvatel. Má poměrně dobrou občanskou vybavenost a zároveň 

rozmanitou přírodu přímo na dosah.  

Benešov je městem, ze kterého se dostanete do centra Prahy během necelé 

hodiny. A přesto je do velké míry městem nezávislým. Přestože je Benešov 

s hlavním městem v každodenním vztahu. Je centrem vlastní poměrně velké 

spádové oblasti. A to nejen pro menší obce v blízkém okolí ale i pro větší města 

vzdálená i více než 20 km (např. Votice, Vlašim, Neveklov nebo Týnec nad 

Sázavou). To je dáno především polohou města, které je zasazeno uprostřed 

členité krajiny plné lesů a neúrodných půd. Středočeská pahorkatina byla 

vždy méně příznivá pro zakládání měst zejména v porovnání s rovinatým 

úrodným povodím Labe ve Středočeském kraji.  

1.1.1 Historie města 

Město Benešov založil na vrchu Karlově rod Benešoviců v první polovině 

11. století. Jednalo se o panský dvorec s kostelem a osadou. Opevněné sídlo 

na Karlově střežilo významnou zemskou cestu spojující Prahu s jihem Čech a 

s Rakouskem. Fakticky se Benešov nachází na půli tehdy dvoudenní cesty 

mezi Prahou a Táborem. Díky této poloze zastavovali cestující v místních 

hostincích, čímž vzrůstal i význam podhradí, zejména řemesel.  

V první polovině 13. století bylo jihozápadně od panského dvorce na zemské 

cestě založeno tržiště. Později pak byl postaven minoritský klášter s  chrámem 

Panny Marie. V druhé polovině 13. století začal stavět Tobiáš z Benešova 

nedaleko hrad Konopiště. V roce 1327 daroval poslední žijící z rodu 

Benešoviců konopišťské panství s městem Benešov rodu Šternberků.  

Roku 1420 vypálili Husité minoritský klášter včetně gotického chrámu a požár 

zničil téměř celé město. Město se však vzpamatovalo a koncem 15. století a 

ve století 16. město opět prosperovalo. Rozrůstala se městská zástavba, 

doprostřed tržiště byl postaven blok s radnicí, chlebnými a masnými krámy. 

Ve města byla škola, farní kostel, lázeň, šatlava a pastouška. Město vybíralo 

celní poplatky na opravu cest a mělo várečné právo i právo šenku vína. 

Počátkem 17. století koupila konopišťské panství Dorota Hodějovská 

z Harasova a nechala přestavit zámek ve stylu pozdní renesance. 
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Hodějovským byl však po bitvě na Bílé hoře majetek zkonfiskován a v roce 

1623 jej koupil Albrecht z Valdštejna, od něj ještě toho roku Pavel Michna 

z Vacínova. Ten obyvatele poddanského města rekatolizoval, ale během 

třicetileté války celé panství znovu strádalo. V roce 1648 bylo švédskými 

vojsky dobyto Konopiště a město Benešov bylo po letech opět vypáleno. 

Z neblahých následků dob třicetileté války se město dostávalo dlouhá 

desetiletí.  

Na počátku 18. století se díky příchodu piaristů a výstavbě piaristické koleje 

s kostelem sv. Anny začalo město stávat centrem vzdělanosti celého regionu. 

Piaristé vytvářeli centrum kultury a vzdělávali občany. Počátkem 20. století 

nechali Piaristé vystavět ve městě novou budovu gymnázia. 

 

Obrázek 1 a 2 - Historické fotografie z počátku 20. stol. – vlevo benešovské náměstí 

s kostelem sv. Anny a vpravo budova benešovského gymnázia 

Koncem 19. století byla dokončena stavba železnice z Prahy přes Benešov do 

Českých Budějovic, a konopišťské panství koupil František Ferdinand d’Este. 

Ten nechal přestavět zámek do dnešní podoby. 

 
Obrázek 2 gfg 

Obrázek 3 - Novogotická úprava zámku Konopiště podle J. Mockera z konce 19. stol 

Z podzámčí byly vystěhovány průmyslové podniky do Benešova, což rozvoji 

města velmi pomohlo. Vzniklo zde mnoho nových staveb, mezi nimi i 

Ferdinandův pivovar nebo nemocnice Rudolfa a Stefanie. 
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Obrázek 4 a 5 - Historické fotografie z počátku 20. stol. – vlevo pivovar Ferdinand 

a vpravo nemocnice Rudolfa a Stefanie 

Během druhé světové války mělo v Benešově sídlo vedení cvičiště vojenských 

jednotek SS a od Benešova až k řece Vltavě, dnešní vodní nádrži Slapy, se 

všichni obyvatelé museli vystěhovat. V období minulého režimu město přišlo 

o velkou část kompaktní historické zástavby. [1, 2, 3] 

1.2 Okres Benešov 

Okres Benešov je svou rozlohou 1475 km2 druhým největším okresem ve 

Středočeském kraji, hustota zalidnění je zde však druhá nejnižší v kraji a to 

66,1 obyv./km2, celkem zde žije 97,5 tisíce obyvatel.  

Dnes je Benešovský okres dle legislativy územně rozdělen na tři části obcí 

s rozšířenou působností (Benešov, Vlašim, Votice) a na pět správních obvodů 

obcí s pověřeným obecním úřadem (Benešov, Sázava, Týnec nad Sázavou, 

Vlašim, Votice). [4] 

Benešovsko někdy také nazývané Posázaví, díky protékající řece Sázavě, se 

rozkládá na západní části Středočeské pahorkatiny, která je zde podrobněji 

rozdělena na menší pahorkatiny (Benešovskou, Konopišťskou a Vlašimskou) 

a také vrchoviny (Neveklovskou, Popovickou, Divišovskou a Netvořickou). 

Z nichž nejvýznamnějším vrcholkem je pro Benešovsko právě hora Blaník, 

podle níž se tomuto kraji přezdívá někdy také Podblanicko. 

Severovýchodní část hranice Benešovského okresu se více či méně přibližuje 

povodí řeky Sázavy (hranice s okresy Praha východ a západ), na východě pak 

podpořené trasou dálnice D1 (hranice s okresem Kutná Hora). Na západě je 

pak hranice tvořena částečně vodní nádrží Slapy a dále vede na jih po hranici 

Příbramského okresu a pokračuje po rozhraní Středočeského kraje s krajem 

Jihočeským a Vysočinou. Zde už není hranice jednoznačně geomorfologicky 

určena.  
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2 Teoretické základy 

Mapa je podle národní definice zmenšený generalizovaný konvenční obraz 

Země, nebeských těles, kosmu či jejich částí, převedený do roviny pomocí 

matematicky definovaných vztahů (kartografickým zobrazením), ukazující 

podle zvolených hledisek polohu, stav a vztahy přírodních, 

socioekonomických a technických objektů a jevů. [5] 

Tematické mapy podle Terminologického slovníku zeměměřictví a katastru 

nemovitostí slouží k zobrazení přírodních, sociálně-ekonomických 

a technických objektů a jevů a jejich vztahů na podkladu základní mapy, 

popř. na redukovaném podkladu základní mapy nebo obecně geografické 

mapy. [6]  

Podle T. A. Slocuma jsou tematické mapy používány pro zdůraznění 

prostorového uspořádání jedné nebo více geografických informací, jako je 

například hustota obyvatelstva, příjmy rodiny, denní teplotní maxima a 

minima a další. [7] 

Tematické mapy jsou podle V. Voženílka specifické svým obsahem, v němž 

převládají prvky jednoho nebo více příbuzných témat nad jinými prvky, které 

jsou z hlediska zájmu tematické mapy podřadné, obsah tematických map je 

rozdělen na topografický podklad a tematický obsah. [8] 

Mapovým souborem je kolekce map, které společně popisují zájmové území 

nebo stanovenou problematiku. Mapy v takovém souboru jsou vyhotoveny 

a uspořádány podle jednotné koncepce. Jednotlivé mapové listy mají v rámci 

mapového souboru ucelený systém označování, stejné zobrazení, jednotný 

značkový klíč. Měřítko a rozměr mapy se mohou lišit v závislosti 

na zobrazovaném území (kraj/okres/město). [9] 

2.1 Kompozice mapy 

Kompozice mapy má velký vliv na první dojem, kterým mapa na čtenáře 

působí. Jedná se o vzájemné uspořádání kompozičních prvků na mapovém 

listu, závisí na tvaru znázorňovaného území, a na formátu mapového listu. 

Kompozice mapy by měla splňovat tři požadavky. Měla by obsahovat všechny 

základní kompoziční prvky, měla by být vyvážená (bez prázdných nebo 

přeplněných míst) a měla by vytvářet dobrý estetický dojem. [10] 

2.1.1 Kompoziční prvky 

Základní kompoziční prvky by měla obsahovat každá mapa. Výjimkou mohou 

být například atlasové mapy, u nichž bývá legenda a tiráž společná pro celé 

knižní dílo. 
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Mapové pole – Mapové pole bývá určeno obrysem zájmového území, od něhož 

se dále odvíjí umístění ostatních kompozičních prvků. V mapovém poli jsou 

vykreslena mapovaná témata. 

Název – Název mapy by měl být stručný avšak jednoznačně určující věcné, 

prostorové a časové vymezení mapovaného tématu. V názvu mapy se neuvádí 

časové vymezení v případě, že se jedná o jev neměnný v čase (např. půdní 

typy, apod.) Dále se pak také neuvádí prostorové vymezení, jedná-li se o 

soubor map, pro něž je toto prostorové vymezení uvedeno jednotně. Název 

může být rozdělen na titul a podtitul. 

Legenda – Legenda tematické mapy interpretuje použité kartografické znaky 

a další vyjadřovací prostředky v konkrétní mapě. Tvorba legendy by měla ctít 

několik zásad. Úplnost legendy – vše co se nachází v mapě, by mělo být 

obsaženo v legendě. Nezávislost legendy – každému jevu by měl odpovídat 

právě jeden znak a naopak. Uspořádání legendy – legenda by měla být 

tematicky uspořádána dle znázorňovaných jevů a tyto kategorie pak dále 

uspořádány hierarchicky.  Soulad legendy s označením v mapě – neshoda 

provedení znaků v legendě s provedením znaků v mapě není přípustná, může 

být totiž vykládána jako ztvárnění odlišné kvality nebo kvantity 

znázorňovaného jevu.  Srozumitelnost legendy – legenda by měla být názorná 

a zřejmá, snadno čitelná, jednotlivé kartografické znaky by měly být lehce 

zapamatovatelné, popisy významu znaků by měly být stručné.  

Měřítko – Měřítko jako kompoziční prvek mapy může být grafické nebo číselné. 

Grafické měřítko je tvořeno měřítkovou linií, která je dělená kótami 

a definována číselným popisem, za poslední číslicí se uvádí jednotka v jazyce 

mapy. Číselné měřítko se zapisuje ve tvaru 1:d, kde d je měřítkové číslo. 

Měřítkové číslo udává, kolikrát je jednotka délky ve skutečnosti větší než 

jednotka délky v mapě. Měřítko mapy je potřeba vnímat dvojím způsobem. A 

je nezbytné tyto způsoby od sebe odlišit. Měřítko jako konstrukční prvek, je 

totiž rozhodující již při zpracování mapového listu a slouží jako hlavní ukazatel 

stupně podrobnosti obsahu mapy. Často bývá stanoveno až po důkladných 

rozborech mapového obsahu a znakového klíče. U souboru map by měla být 

sousední měřítková čísla násobky nebo podíly. 

Tiráž – Tiráž by měla vždy obsahovat jméno autora nebo vydavatele mapy, 

místo a rok vydání nebo sestavení mapy. 

Doplňujícími kompozičními prvky mohou být například: směrovka, tabulka, 

graf, schéma, vedlejší mapa, obrázek, textové pole, logo, reklama a další. [10, 

11] 
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2.2 Koncepce map 

Tematická mapa by měla ideálně vznikat za spolupráce kartografa s 

odborníkem na dané téma. Podle koncepce můžeme tematické mapy rozdělit 

na analytické, komplexní a syntetické. 

Analytické mapy obsahují prvky tak, jak byly zjištěny v terénu s minimálním 

zásahem do zobecnění obsahu, jde zejména o zobrazení rozmístění 

mapovaných objektů jednou kartografickou metodou. 

Komplexní mapy obsahují více jevů blízkého tématu ale odlišného původu. 

Vznikají za spolupráce odborníků různých oborů a umožňují vzájemné 

srovnání zobrazovaných témat tak jednotlivých objektů. Využívají kombinace 

různých zobrazovacích metod.  

Syntetické mapy obsahují vzájemné souvislosti a vztahy různých jevů. 

Vyjadřují informace vyvozené cestou myšlenkových pochodů, zvláště 

generalizace a abstrakce. Znázorňují více jevů, které by komplexní mapa 

nemohla srozumitelně obsáhnout, jejich sloučením, čímž vznikne nová 

kvalita, která může být zobrazena samostatně. [8] 

2.2.1 Všeobecné zásady tvorby tematických map 

Zásada jednoty – Tematická mapa se skládá ze tří přístupů, které by měly být 

jednotné: odborný, technický a estetický přístup. Zároveň by všechny části 

mapy měly být zpracovány jednotně a se stejnou pečlivostí, nemělo by dojít 

ke vzniku tzv. „hluchých“ míst. 

Zásada koordinace – Práce na tematické mapě by měla být vždy rozdělena 

do dvou fází. V první, tzv. pracovní fázi se řeší tematický obsah mapy 

(spolupráce s odborníkem daného tématu). Ve druhé fázi se pak řeší technický 

obsah mapy a celková estetika (práce kartografa). Kartograf by měl svou práci 

konzultovat s autorem tematického obsahu mapy. 

Zásada jednoduchosti – „V jednoduchosti je krása“. Moderní nástroje nabízí 

mnoho možností zpracování dat. Při jejich nadměrném využití se však mapa 

může stát přeplněnou až nečitelnou. Jednoduchost mapy je stěžejní ve všech 

částech mapy (kompozice, podkladu, legendy, znakového klíče, popisu atd.) 

Jednoduchá mapa tak paradoxně sdělí svému čtenáři více informací než mapa 

složitá. 

Zásada prostorové názornosti – Podstatnou předností tematických map 

je prostorové zobrazení podrobností daného tématu. Cílem kartografa je tedy 

vyjádřit dané téma názorně s ohledem na měřítko mapy. Mapa se čte ze dvou 

vzdáleností. Z větší vzdálenosti se hodnotí kompozice mapy, prostorové 

rozmístění jejích prvků. Z menší vzdálenosti se pak pozorují detaily obsahu 

mapy, popis, znaky. 
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Zásada srozumitelnosti – Všechny prvky mapy by měly být jasné 

a srozumitelné (jasně a stručně formulovaný název, srozumitelná a logicky 

uspořádaná legenda, snadno rozlišitelné barvy a znaky). Vyjadřovací jazyk 

by měl být srozumitelný nejen autorovi, ale především čtenářům, kterým 

je mapa určena.  

Zásada zvýraznění dominant – Nejpodstatnější prvek tematického obsahu 

mapy by měl být graficky nejvýraznější. Je zde nezbytné sledovat konceptuální 

řetězec: téma » název » hlavní vyjadřovací prostředek » legenda. Tedy: téma 

by mělo být stanoveno v názvu mapy, ztvárněno hlavním a nejvýraznějším 

vyjadřovacím prostředkem a ten by pak měl být umístěn na začátku legendy. 

Určení dominant závisí na úvaze: co je důležité dle cíle mapy, co je 

charakteristické pro hlavní téma mapy nebo co je jedinečné a zvláštní 

v mapovaném území. 

Zásada výběru – Jevy zobrazované v tematické mapě se vybírají na úkor jevů 

nepodstatných, což úzce souvisí s kartografickou generalizací a meřítkem 

mapy. Téma mapy je určeno jejím názvem, v němž by mělo být jednoznačně 

uvedeno trojí vymezení hlavního tématu – věcné, prostorové a časové. Bez 

tohoto vymezení není možné obsah mapy správně interpretovat. Výběr prvků 

pro obsah mapy by měl být různý pro tvorbu analytické, komplexní 

a syntetické tematické mapy. 

Zásada měřítka – Pro různá měřítka se mapa sestavuje specifickým způsobem.  

Je třeba zvážit výběr prvků obsahu mapy, různé stupně generalizace, formu 

znázornění, úpravu značkového klíče atd.  

Zásada generalizace – V mapě malého měřítka nelze zobrazit podrobné 

prostorové souvislosti z mapy velkého měřítka, proto je nezbytná generalizace 

dat. Kartografická generalizace často vychází z vědecko-výzkumných metod 

a rozhodnutí tematika, do značné míry bývá subjektivní. [10] 

2.3 Metody tematické kartografie 

Metody tematické kartografie nám pomáhají systematicky rozdělit 

kartografické vyjadřovací prostředky tak, abychom je dokázali vhodně využít. 

Údaje zaznamenané v mapě mohou být dvojího charakteru. Kvantitativní 

anebo kvalitativní. Zatímco kvalitativní údaj nese informaci o druhu nebo 

vlastnosti daného jevu, jež hovoří o kvalitách, které jsou navzájem rozdílné 

(nominální), nanejvýš pak subjektivně seřiditelné (ordinální). Kvantitativní 

údaj pak popisuje vlastní hodnoty, velikost či četnost zastoupení daného jevu. 

Kvantitativní údaj je proměnná veličina, která nabývá různých hodnot. Tyto 

hodnoty mohou být absolutní nebo relativní. Dále je můžeme rozdělit na 

intervalové a poměrové hodnoty. Kvantitativní data mohou být také rozdělena 

na diskrétní a spojitá. 
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Existují různá dělení metod tematické kartografie, která se vzájemně liší 

rozdílnými přístupy autorů ale také stupněm úrovně podrobnosti klasifikace. 

Jen v české literatuře je rozdělení hned několik, například dělení podle 

Doc. RNDr. Jaromíra Kaňoka, CSc., Doc. RNDr. Milana Václava 

Drápely, CSc., nebo Prof. Ing. Bohuslava Veverky, DrSc., a další. 

Já jsem se ale rozhodla v této práci popsat metody tematické kartografie dle 

Prof. RNDr. Víta Voženílka, CSc., jehož publikace patří mezi nejrozšířenější. 

Obecně se dají metody tematické kartografie rozdělit do dvou skupin: metody 

pro zobrazení kvalitativních dat (metody bodových, liniových a plošných 

znaků) a pro zobrazení kvantitativních dat (metody teček a izolinií, 

dasymetrická metoda, metody kartodiagramu, kartogramu a kartotypogramu, 

metoda kartografické anamorfózy a metoda pro vyjádření dynamiky 

prostorových jevů). [10, 12] 

2.3.1 Metoda bodových znaků 

 
Obrázek 5 

Obrázek 6 - Metoda bodových znaků - výřez z mapového listu Doprava 

Bodovým nebo také figurálním znakem lze vyjádřit bodový jev (např. nivelační 

bod, výškovou kótu, …) anebo jev plošný, jehož skutečnou plochu ale nelze 

v daném měřítku vyjádřit (např. letiště, město, …).  

Pomocí bodových znaků lze vyjádřit zájmový údaj různými způsoby. Podle 

formy se znaky dělí na geometrické, symbolické, obrázkové a siluetové, 

alfanumerické. 

Geometrické znaky jsou tvořeny jednoduchými geometrickými tvary (čtverec, 

kruh, trojúhelník, pětiúhelník, …), jsou snadno a rychle rozlišitelné, avšak 

většinou velmi abstraktní. 

Symbolické znaky se snaží zjednodušenými kresbami čtenáři vizuálně přiblížit 

znázorňovaný jev, jsou nejvíce používanými značkami.  
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Obrázkové a siluetové znaky znázorňují v kresbě konkrétní objekty. Tyto 

znaky se většinou neuvádějí do legendy, jelikož je jejich kresba dostatečně 

určující. Příkladem obrázkového, případně siluetového znaku by mohl být 

zámek Konopiště vykreslený v mapě, zatímco symbolický znak zámku by 

popisoval obecně kategorii hradů a zámků. 

Alfanumerické znaky jsou tvořeny číslicemi nebo písmeny které souvisí 

se zobrazovaným jevem. Například P – parkoviště, Fe – těžba železa. Takové 

znaky však musí být výrazně odlišné od popisu mapy. 

Různou kvalitu zobrazovaných jevů lze znázornit díky struktuře, výplni, 

orientaci a velikosti bodových znaků.  

Strukturou bodového znaku je jeho vnitřní členění. Může vyjadřovat 

kvantitativní vztahy mezi jednotlivými složkami jevu nebo podobné vazby 

v rámci několika jevů zobrazovaných jedním znakem. Struktura znaku může 

být pouze estetickým nástrojem ke snadnějšímu rozlišení. 

Výplň bodového znaku je realizována barvou nebo rastrem a vyjadřuje kvalitu 

znázorňovaného jevu nebo jeho dílčích složek. 

Orientace bodového znaku musí být v celé mapě konstantní, pokud nemají být 

takové znaky chápány jako kvalitativně odlišné. Orientace bodového znaku 

vyjadřuje jeho vztah k souřadnicové síti, k jinému objektu nebo ke směru 

pohybu. 

Velikost bodového znaku musí být v celé mapě konstantní, pokud znak 

vyjadřuje kvalitu jevu. Kvantita jevu je však vyjadřována právě díky velikosti 

bodového znaku, která je závislá na hodnotě zobrazovaného jevu. 

Při změně těchto parametrů dochází k dojmu, že jde o nové znaky vyjadřující 

jiné jevy, přestože jde o původně stejné kartografické znaky.  
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2.3.2 Metoda liniových znaků 

 

Obrázek 7 - Metoda liniových znaků, hraniční liniové znaky – výřez z vrstvy hranic obcí 

Liniovými nebo také čárovými znaky vyjadřujeme polohu liniových objektů, 

průběh hranic či vývoj a směr pohybu. Podle toho, co znaky znázorňují 

je možné je rozdělit na identifikační, hraniční a pohybové. 

Identifikační liniové znaky umožňují znázornit objekty, které jsou určeny 

jedním převládajícím rozměrem - délkou, zatímco šířka takového objektu je 

v měřítku mapy zanedbatelná (například: vodní toky, komunikace, …).   

Hraniční liniové znaky definují rozhraní ploch se stejnou kvalitativní 

charakteristikou (např. hranice administrativních celků, hranice 

pozemků, …) nebo ohraničují samostatné objekty či areály. 

Pohybové liniové znaky popisují změny určitého jevu v místě a čase. Mohou 

vyjadřovat převládající trend v pohybu, případně dynamiku znázorňovaného 

jevu. 

Podobně jako u bodových znaků můžeme i u liniových znaků vyjádřit kvalitu 

zobrazovaných jevů pomocí struktury, výplně, orientace a tloušťky. 

Struktura liniového znaku je tvořena dílčími grafickými prvky, jejichž liniovým 

sestavením vznikají plné, čárkované, tečkované, čerchované a jiné linie. 

Mohou vznikat i složitější linie dvojité nebo linie doplněné doprovodnými 

znaky. Struktura použitého liniového znaku většinou respektuje zavedené 

zvyky (např. plná modrá linie značí povrchový vodní tok, čárkovaná občasný 

a tečkovaná podpovrchový vodní tok). 

Výplň liniového znaku bývá realizována především barvou. Barva je v mapě 

obecně vnímána velmi citlivě. A proto barevné odlišení nejen liniových jevů 

jednoznačně vyjadřuje jejich kvalitativní různost. Volba konkrétních barev 

se řídí pravidly používání barev v mapách (viz. kapitola 2.4.2 Barva). 
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Orientace liniového znaku znázorňuje jeho významný směr. Linie může být 

orientována jednostranně i oboustranně a podélně nebo příčně. Podélná 

orientace bývá vyjádřena šipkou, jež značí směr podle vlastní linie (např. směr 

přesunu cestujících). Příčná orientace vyjadřuje, na které straně podélné osy 

působí zobrazovaný jev (např. studené, teplé a okluzní fronty 

v meteorologických mapách). Znaky příčné orientace jsou osově nesouměrné. 

Tloušťka liniového znaku je příčnou vzdáleností okrajů liniové kresby. Pomocí 

tohoto parametru lze vyjádřit kvantitu znázorňovaného jevu na liniovém 

objektu – tloušťka liniového znaku závisí na hodnotě jevu (např. intenzita 

dopravy, říční průtok, …). V takových případech je nutné doplnit mapu 

odpovídající intervalovou stupnicí. Tloušťka liniového znaku se také využívá 

k odlišení významu jevů podle kvalit (např. hranice obecní, krajské 

a státní, …). 

2.3.3 Metoda plošných znaků  

 

Obrázek 8 - Metoda plošných znaků – výřez z mapového listu Výšky budov 

Metoda plošných znaků nebo také areálová metoda slouží v tematické 

kartografii k vyznačení zájmových ploch, které lze jako plochy zakreslit 

v měřítku dané mapy. Tyto areály bývají většinou ohraničené a podle jejich 

prostorového uspořádání je můžeme rozdělit na izolované, dotykové 

a překrývající se. Izolované areály mají ostrovní povahu a reprezentují 

například vymezení Chráněnou krajinnou oblast. Dotykové areály mají mezi 

sebou společné hranice a vytváří tak souvislou oblast (např. hranice 

administrativních celků). Překrývající se areály zobrazují jevy, které se 

vzájemně prolínají (takové plochy bývají vyplněny rastrem, aby byla zachována 

čitelnost překrytí). 

Pro znázornění kvality zobrazovaného jevu využívá areálová metoda dva 

parametry – výplň a obrys. 

Výplň plošného znaku je realizována barvou nebo rastrem a může vyjadřovat 

kvalitativní i kvantitativní vlastnosti zobrazovaných jevů. Zaplnění plochy 
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konkrétními barvami a rastry se řídí pravidly tematické kartografie (viz. 

kapitola 2.4.2 Barva). 

Obrys plošného znaku má stejné parametry jako liniové znaky. Bývá používán 

pro zobrazení doplňujících informací kvůli své nízké vizuální důraznosti 

(vzhledem ke zbývající ploše). Anebo může určovat například důležitost areálů 

díky své tloušťce či struktuře. 

2.3.4 Metoda teček 

 

Obrázek 9 - Metoda teček – kartogramový způsob 

Metoda teček původně vznikla pro znázornění hustoty zalidnění pomocí 

matematicky odvozeného množství teček jednotné velikosti a váhy. V dnešní 

tematické kartografii se používá především k vyjádření rozmístění diskrétních 

kvantitativních charakteristik, zejména bodových jevů. Rozmístění teček 

v mapě reprezentuje zastoupení daného jevu na určitém území (a jeho 

sledovaných jednotkách), a zároveň ukazuje změnu intenzity a rozptýlení 

tohoto jevu. 

Základním vyjadřovacím prostředkem metody je tzv. kvantifikační tečka, jejíž 

váha je definována konkrétní hodnotou (např. jedna tečka odpovídá 

100 obyv.) a poloha se určuje dvojím způsobem – topografickým 

a rovnoměrným. Topografický nebo také „lokalizovaný“ způsob se používá 

spíše při větších měřítcích, jelikož zohledňuje skutečný výskyt zobrazovaného 

jevu a předpokládá tedy hlubší znalost mapovaného území a topografické 

polohy zobrazovaného jevu. Rovnoměrný způsob lokalizace teček je založen na 

systematicky rovnoměrném rozmístění teček v územních jednotkách, které 

jsou obvykle tvořeny pravidelnou mřížkou, což nevytváří příliš věrný dojem.  
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Díky různým barvám teček je možné vyjádřit současně i kvalitu jevu, 

popřípadě odlišit různé jevy v rámci jedné mapy. Obecně tečková metoda ale 

není příliš vhodná pro kombinování s dalšími zobrazovacími metodami. 

Přestože základem tečkové metody jsou absolutní hodnoty zkoumaného jevu 

v územních jednotkách, metoda teček nezobrazuje přesné rozložení 

zkoumaného jevu, ale dobře reprezentuje relativní hustotu díky vizuálnímu 

vjemu. Jedna tečka by měla reprezentovat více než jeden objekt. Tečky 

v jednotlivých územních jednotkách by měly být spočitatelné, ačkoli není 

záměrem je počítat.  

2.3.5 Metoda izolinií 

 

Obrázek 10 - Metoda izolinií - vrstevnice 

Metoda izolinií zprostředkovává zobrazení tzv. statistického povrchu, který 

je pomocí izolinií reprezentován. Izolinie je čára, která propojuje body 

o stejných hodnotách dané veličiny. Mapy vzniklé touto metodou se nazývají 

izometrické a zobrazují spojité hodnoty, například: nadmořskou výšku, 

teplotu nebo tlak. Pokud je metoda izolinií použita pro nespojité veličiny 

(např. socioekonomické vztahy), vznikají mapy nepravých izolinií či izopletické 

mapy. 

Izolinie vznikají na základě tzv. řídících bodů, respektive interpolací mezi 

těmito body. Řídícím bodem je topograficky lokalizovaný bod, který obsahuje 

konkrétní hodnoty sledovaného jevu. Počet řídících bodů a jejich lokalizace 

mají zásadní vliv na výslednou kvalitu vytvořených izolinií. Od určité hustoty 

těchto řídících bodů však již nedochází k dalšímu výraznému zpřesnění. 

Lokalizace řídících bodů spojitých veličin je dána polohou měřících zařízení. 

U nespojitých dat se řídící body umísťují většinou do středu územních 

jednotek nebo do míst s vysokou koncentrací jevu. 

Interpolace je matematicky definovaný způsob zjišťování zaokrouhlených, 

předem stanovených, hodnot bodů ležících mezi řídícími body. Samotné 

izolinie jsou pak konstruovány jako vyhlazené linie procházející sousedními 
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body se stejnými zaokrouhlenými hodnotami. Izolinie se nemohou větvit ani 

křížit.  

Izolinie jsou v podstatě čáry, které vytvářejí „prostorové intervaly“. Barevným 

odlišením, těchto intervalů může vzniknout barevná hypsometrie (názorné 

zobrazení terénního reliéfu). 

2.3.6 Dasymetrická metoda 

 

Obrázek 11 - Dasymetrická metoda využívající sloučení a editace územních celků v 

kartogramu 

Dasymetrická metoda se používá pro znázornění dat vztažených k ploše, 

barevně sjednocuje oblasti se stejnou intenzitou a umožňuje zaznamenávat 

proměnlivost sledovaného jevu. Nebývá využívána příliš často, jelikož její 

konstrukce je náročnější než tvorba ostatních kartografických metod. Její 

výstupy jsou však mnohem výstižnější.  

Zpracování dat dasymetrickou metodou má několik výhod oproti jiným 

metodám, protože není omezena hranicemi předem stanovených areálů, ale 

hranice přirozeně vznikají až během samotného vyhodnocování územního 

rozložení jevu, její výstupy jsou tak věrnější a přesnější než při zpracování 

metodou kartogramu. A na rozdíl od metody izolinií může vzniknout přímá 

hranice mezi dvěma nesousedními intervaly. 

Základním principem vymezení areálů je kombinace dvou druhů 

dat – hodnoty dat zkoumaného jevu (např. kartogram) a tzv. pomocné 

informace (data, která se týkají rozprostření stejného jevu v dané 

oblasti - např. mapy zpracované metodou teček nebo izolinií, případně 

statistické údaje, …) 
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2.3.7 Metoda kartodiagramu 

 

Obrázek 12 - Metoda strukturního kartodiagramu – vvýřez z mapového listu Využití 

ploch 

Metoda kartodiagramu umožňuje srovnání kvalitativních dat v jednotlivých 

územních celcích. Kartodiagram slouží zejména k zobrazení absolutních 

hodnot, výjimku tvoří členění daného znaku, kde jsou hodnoty uváděny 

v procentech. Nejčastěji se pomocí kartodiagramu prezentují statistické údaje, 

čímž vzniká tzv. statistická mapa.  

Diagram je složitější formou grafu, kde příslušné kvantitativní charakteristiky 

nejsou zobrazeny pouze délkou úsečky, ale plochou rovinného geometrického 

obrazce, obvykle kruhem nebo čtvercem. Diagram je v podstatě znakem, který 

umožňuje vyjádřit kvantitu určitého jevu v daném bodě mapy. Kartodiagram 

je pak soubor lokalizovaných diagramů. Kartodiagramy lze velmi dobře 

kombinovat s ostatními metodami tematické kartografie, např. s metodou 

kartogramu. 

Pro správné vyhotovení kartodiagramu je nezbytné použít vhodné stupnice 

pro celý soubor dat. Takové stupnice mohou být gradační nebo 

proporcionální. Gradace stupnice diagramu představuje přímou závislost mezi 

velikostmi diagramů a odpovídajícími hodnotami vstupních dat. 

Proporcionalita stupnice diagramu zajišťuje, aby vypočtené velikosti diagramů 

měly stejné proporce jako příslušné velikosti statistických dat. Vypočtená 

velikost diagramu se pak v mapě přiřadí k tzv. vztažnému prvku - bodu, linii 

nebo ploše. A právě podle vztažných prvků můžeme kartodiagramy rozdělit na 

bodové, liniové a plošné. Přičemž bodové a plošné kartodiagramy se odlišují 

pouze a právě vztažným prvkem, dále je však můžeme dělit společně. 

Bodový/plošný kartodiagram umožňuje znázornit kvantitativní jevy pomocí 

diagramů vztažených k bodům (např. meteorologickým stanicím) nebo 

plochám (např. regionům). 
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Strukturní kartodiagramy představují soubory stejně velkých, strukturně 

dělených diagramů v bodech/plochách o nichž vypovídají. Součet dílčích 

částí každého z diagramů vyjadřuje 100 % sledovaného jevu. Nelze z nich 

však zjistit absolutní hodnoty. 

Součtové kartodiagramy obsahují nestejně velké součtové diagramy, které 

jsou umístěny v bodech/plochách kterým dané hodnoty patří. Každý 

z diagramů svou velikostí odpovídá hodnotě sledovaného jevu a zároveň 

svým dělením znázorňuje vnitřní strukturu jevu. Kromě dílčích poměrů 

lze z diagramů odečíst i absolutní hodnoty. 

Srovnávací kartodiagramy využívají překrytí dvou diagramů v jeden. 

Z nichž první diagram o konstantní velikosti značí srovnávací hodnotu 

jevu (např. výchozí/střední/optimální hodnotu) a bývá obvykle vykreslen 

jen obrysem. A druhý diagram vyjadřuje svou velikostí konkrétní hodnotu 

sledovaného jevu. Ten bývá vyplněn rastrem. 

Dynamické kartodiagramy slouží k zobrazení časově proměnlivých jevů a 

to díky dynamickým diagramům popisujícím minimálně tři různá časová 

období sledovaného jevu.  

Segmentové kartodiagramy prezentují statistické údaje pomocí 

geometrických obrazců, které představují části celkových hodnot 

sledovaných jevů (větší z obrazců zastupují větší část hodnoty jevu). 

Celková hodnota jevu je pak v daném bodě/ploše součtem dílčích 

segmentů o různých hodnotách. 

Liniový kartodiagram umožňuje znázornit velikost a směr pohybu jevu, právě 

díky liniím, k nimž je vázán. Liniový kartodiagram se používá zejména pro 

znázornění řek, silnic a železnic. 

Vektorový liniový kartodiagram je charakterizován svým počátečním 

bodem, směrem a délkou. Rozlišují se dva druhy vektorového liniového 

kartodiagramu – proudový a dosahový.  

Proudový vektorový kartodiagram se skládá pouze z proudu nebo trsu 

lokalizovaných a směrově orientovaných šipek, bez tzv. centrálního 

bodu. Využívá se k zobrazení mořských nebo vzdušných proudů. 

Kvalita takových proudů se odlišuje barvou, kvantita pak šířkou nebo 

délkou šipky. 

Dosahový vektorový kartodiagram propojuje přímkou centrální bod 

s bodem dosahovým a vyjadřuje tím jejich vzájemný vztah. Délka 

přímky mezi těmito body nemívá jiný význam než právě vzdálenost 

těchto dvou bodů. Kvantita zobrazeného jevu může být vyjádřena 

například tloušťkou této spojnice. 
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Stuhový liniový kartodiagram na rozdíl od vektorového kartodiagramu 

zachovává reálný průběh linií a svou šířkou reprezentuje hodnotu 

zobrazovaného jevu. Tento kartodiagram má mnoho dalších variant, 

z nichž některé odpovídají dělení bodových a plošných kartodiagramů 

(strukturní, součtové, srovnávací, dynamické a segmentové), dalšími pak 

jsou kartogramy izochronický, jednosměrný, dvousměrný aj. 

 

Obrázek 13 - Stuhový liniový kartodiagram – výřez z mapového listu Intenzita dopravy 

Podle počtu znázorňovaných jevů můžeme kartodiagramy dělit na jednoduché 

a složené. 

Jednoduchý kartodiagram zobrazuje pouze jeden jev, který je 

reprezentován jedním druhem kartodiagramu. 

Složený kartodiagram zobrazuje současně více jevů. Každý z těchto jevů je 

znázorněn jiným typem diagramu. Nebo jsou tyto jevy znázorněny stejným 

způsobem, ale kvalitativně rozlišeny barvou nebo rastrem. 

Kartodiagramy můžeme také rozdělit podle počtu jednotek zobrazovaných 

hodnot na kartodiagramy jednoměřítkové či víceměřítkové nebo podle obsahu 

na kartodiagramy vycházející z věcných, časových či prostorových údajů 

a mnoho dalších.  
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2.3.8 Metoda kartogramu 

 

Obrázek 14 - Metoda kartogramu – výřez z mapového listu Obyvatelstvo 

Metoda kartogramu zprostředkovává kvantitativní srovnání jednotlivých 

územních celků. Základní podmínkou pro použití metody kartogramu jsou 

data vyjádřená relativními hodnotami tak, aby dílčí územní celky byly 

srovnatelné. Proto musí být kvantitativní data vždy přepočtena na jednotku 

plochy daného územního celku (např. počet obyvatel na 1 km2). Pokud 

vyjadřujeme data vztažená pouze k části dílčího územního celku (např. počet 

obyvatel na 1 km2 zastavěné plochy) nebo dokonce vztažená k jinému údaji 

(např. počet obyvatel na jednoho lékaře), nejedná se o kartogram, nýbrž o 

nepravý kartogram nebo také pseudokartogram. 

Podle počtu znázorňovaných jevů a způsobu jejich interpretace můžeme 

kartogramy různě dělit na jednoduché a složené, na strukturní, tečkové, 

čárové a mnoho dalších. Několik nejpoužívanějších druhů je blíže popsáno 

v následujících odstavcích. 

Jednoduchý kartogram vyjadřuje právě jeden jev pomocí rastrové nebo 

barevné výplně. Jednoduché kartogramy můžeme dále rozdělit dle formy 

znázornění daného jevu na homogenní, kvalifikační, selektivní, tečkové a 

geometrické. 

Homogenní jednoduchý kartogram je nejjednodušší a nejpoužívanější 

formou kartogramu. Jednotlivým územním celkům jsou přiřazeny barevné 

nebo rastrové výplně podle předem stanovené stupnice. 

Kvalifikační jednoduchý kartogram klade důraz na průměrnou hodnotu 

nebo hodnotu střední hladiny intenzity jevu na celém území. Ve stupnici 

jsou pak rozdílným rastrem nebo barvou vyznačeny intervaly nad a pod 

střední hodnotou, přičemž intenzita se zvětšuje od středu oběma směry. 

Jsou-li pro stupnice použity barvy, je vhodné zvolit odstíny jednoznačně 

odlišné a to v závislosti na zobrazovaném jevu (např. teplé x studené nebo 

výrazné x nevýrazné).   
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Selektivní jednoduchý kartogram se používá pro jevy, které jsou 

reprezentovány dvěma nebo více kategoriemi, kde snižování hodnot jedné 

kategorie vede k úměrnému zvyšování kategorie jiné 

(např. přírůstek/úbytek). 

Tečkový jednoduchý kartogram je založený na pravidelné síti teček, které 

se přizpůsobují svou velikostí intenzitě zobrazovaného jevu podle své 

polohy resp. náležitosti k územním jednotkám. Je důležité vhodně zvolit 

velikosti teček vzhledem k jejich rozestupům, aby nedošlo k jejich překrytí 

a ztrátě vypovídací schopnosti. 

Geometrický jednoduchý kartogram představuje rovnoměrné rozdělení 

zobrazovaného území na shodné obrazce (např. čtverce nebo 

šestiúhelníky), v nichž mohou být hodnoty vyjádřeny běžným způsobem 

jednoduchých kartogramů. 

Složený kartogram slouží k zobrazení dvou i více jevů a jejich jednoduchému 

vzájemnému srovnání. Složený kartogram vznikne překrytím jednoduchých 

kartogramů, které jsou vzájemně snadno odlišitelné. Může se jednat například 

o kombinaci vodorovného a svislého rastru. A stupnice dílčích kartogramů 

musí být zpracovány shodnou výpočtovou metodou.  

Korelační složený kartogram zobrazuje takové jevy, u nichž je statistickými 

metodami prokázána vzájemná závislost. 

Pseudokorelační složený kartogram zobrazuje jevy, jejichž závislost 

statisticky prokázaná není, ale jejich vztah je z grafického znázornění 

patrný.  

Strukturní kartogram umožňuje zobrazit intenzitu vnitřní struktury 

sledovaného jevu na vymezeném území. Takové území je rozděleno na stejně 

široké, rovnoběžné pásy. Je vhodné, aby nejmenší dílčí jednotkou procházely 

alespoň dva z těchto pásů, přičemž každý z pásů představuje 100 % 

sledovaného jevu. Procentní složení struktury sledovaného jevu je pak 

vyjádřeno vnitřním dělením jednotlivých pásů. Podle struktury jednotlivých 

jevů můžeme strukturní kartogramy dále rozdělit. 

Plynulý strukturní kartogram zaznamenává vnitřní dělení pásů podle 

skutečných podílů z celkového jevu. Pásy jsou děleny podle plynulé 

stupnice, což může vést k tomu, že některá data nelze graficky 

zaznamenat. 

Strukturní kartogram se skokovou stupnicí zaznamenává podíly 

z celkového jevu do předem stanovených procentních dílů pásu. Stupnice 

je tedy v tomto případě dělena skokově (např. po 10% nebo 20%). 
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Výběrový strukturní kartogram může znázorňovat vybrané minimální nebo 

maximální hodnoty. Výběrový strukturní kartogram se používá v případě, 

že chceme z celkové struktury jevu zobrazit pouze část celku, která 

přesahuje stanovenou mez, tedy mez minimální nebo maximální. 

V případě minimálního výběrového strukturního kartogramu můžeme 

srovnávat zejména plochy, které mohly být v předchozích typech 

strukturních kartogramů zanedbány. 

Tečkový kartogram umožňuje zobrazení rostoucí intenzity sledovaného jevu 

postupným zahušťováním teček v dílčích územních celcích. Aby nedošlo 

k příliš hustému zaplnění plochy tečkami, používá se variační rozpětí (tj. rozdíl 

mezi minimální a maximální hodnotou souboru). Díky jednotné hodnotě teček 

v celé mapě můžeme jednoduchým výpočtem zjistit konkrétní číselné hodnoty 

jevu v dílčích územích. 

Přirozený tečkový kartogram zobrazuje tečky do primárních plošek 

kartogramu, tedy do dílčích územních jednotek. 

Geometrický tečkový kartogram se odlišuje tvarem polí, do nichž jsou tečky 

zobrazeny. Zájmové území je v tomto případě rozděleno na pravidelné 

geometrické obrazce, do nichž jsou tečky vykresleny. 

Pseudogeometrický tečkový kartogram je zvláštním případem tečkového 

geometrického kartogramu. V každé ploše kartogramu je umístěn právě 

jeden geometrický obrazec, uvnitř něhož je hustotou teček znázorněna 

intenzita sledovaného jevu. Hodnoty sledovaného jevu nejsou vztaženy 

k odpovídající ploše, nýbrž ke konstantní ploše, ploše geometrického 

obrazce. 

Prostorový kartogram je ve své podstatě kartogramem jednoduchým, s tím 

rozdílem, že kvantita dat v příslušných areálech není reprezentována barvou 

nebo rastrem, ale třetím rozměrem. Konkrétně výškou jednotlivých areálů nad 

(nebo i pod) základnami vlastních půdorysů. Pro lepší čitelnost bývají tyto 

mapy zobrazovány z šikmého nadhledu.  
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2.3.9 Metoda kartografické anamorfózy 

 

Obrázek 15 - Metoda kartografické anamorfózy - Ekvivalentní plošná anamorfóza 

kartogramu 

Kartografická anamorfóza je abstraktní přeměna geometrického základu 

mapy, pro jasnější vyjádření tematického obsahu mapy. Využívá se především 

ve státech severní Ameriky, v české kartografii není příliš běžná. Mapy vzniklé 

kartografickou anamorfózou jsou atraktivní pro své čtenáře díky vytvoření 

názorné představy o dané tematice. 

Prostřednictvím kartografické anamorfózy záměrně deformujeme topologický 

podklad mapy (tvary, plochy, délky, …) abychom v ní vyzdvihli vybrané 

tematické prvky. Výsledkem je pak zkreslený obraz mapy zobrazující 

například plošné prvky, které ale vyjadřují jiné jevy namísto původní plochy 

(např. počet obyvatel). Taková mapa ovšem vyžaduje speciální přístup 

k interpretaci a měla by být prostorově podobná mapě původní.  

Metody kartografické anamorfózy se rozdělují s ohledem na pravidla, podle 

nichž se proměňují (anamorfují) na radiální a neradiální anamorfózu. 

Radiální anamorfóza přeměňuje prvky mapy provedením kružnic nebo jim 

přibližných tvarů soustředných kolem tzv. centrického bodu v závislosti na 

vzdálenosti od tohoto středu. Využívá se k zobrazení geografických jevů 

soustředěných kolem důležitého centra (např. dopravní dostupnost do města). 

Pokud se jedná o tzv. matematickou radiální anamorfózu, vypočítávají se 

odstupy vyjadřovaného jevu podle matematických předpisů. Jedná-li se o 

geografickou radiální anamorfózu, závisí tvar a rozmístění křivek na 

velikostech konkrétního geografického jevu. 

Neradiální anamorfóza přeměňuje velikosti ploch prvků mapy a může 

zachovávat přibližné tvary těchto prvků nebo je zjednodušuje v geometrické 

obrazce. Také může zachovávat nebo porušovat sousedství územních 

jednotek. Neradiální anamorfóza, která zjednodušuje tvary hranic a přitom 

zachovává sousedství, se nazývá souvislou. Naopak nesouvislá neradiální 
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anamorfóza zachovává tvary územních celků, avšak nedodržuje jejich 

sousedství. 

Kartografickou anamorfózou na pomezí těchto dvou metod je anamorfóza 

osová, která deformuje podkladovou mapu podle určité osy (přímky či křivky). 

2.3.10 Metoda kartotypogramu  

 

Obrázek 16 – Metoda Kartotoypogramu - součtový kartotypogram 

Kartotypogramy slouží k vymezování typologie jevu. Umožňují setřídit vybrané 

jevy podle podobných znaků napříč zájmovým územím.   

Základním nositelem informace je v tomto případě typogram. Typogram je 

vyjadřovacím prostředkem podobným diagramu, ale na rozdíl od něj sděluje 

informace prostřednictvím svého tvaru. Typogram vyjadřuje relativní hodnoty 

(nejčastěji procenta), zatímco centrogram vyjadřuje hodnoty absolutní. 

Typogram je realizován soustavou souřadnicových os, kde každá z os 

reprezentuje vždy jednu dílčí část sledovaného jevu. Hodnoty na jednotlivých 

osách typogramu jsou pak pospojovány, čímž vzniknou uvnitř vzniklého n-

úhelníku čitelnější plochy a sledovaný tvar tak lépe vynikne. Uplatňuje se tak 

proces tzv. typizace – podobné tvary poukazují na podobnost pozorovaných 

hodnot v daných územích. 

Kartotypogramy pak můžeme rozdělit podle toho, jaké procentuální hodnoty 

reprezentují. Pokud zobrazuje každý jeden typogram 100 % dílčích částí 

sledovaného jevu, jde o typogram strukturní. V případě, že je jeden jev 

charakterizován všemi typogramy napříč celým zájmovým územím. Tedy, že 

součet hodnot na odpovídajících si polopřímkách (např. pravostranných) 

je roven 100 % sledovaného jevu, jedná se o typogramy součtové.  

Literatura o rozdělení metod tematické kartografie není vždy zcela jednotná, 

tyto kapitoly proto vznikaly na podkladu několika různých tištěných i 
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internetových zdrojů [9, 10, 11, 13, 14, 15], ale také na základě vlastního 

vnímání kartografických metod.  

2.4 Vlastnosti vyjadřovacích prostředků  

Výše popsané metody tematické kartografie jsou ztvárněny pomocí základních 

kartografických vyjadřovacích prostředků – bodových, liniových a plošných 

znaků, grafů a diagramů.  

Zvláštní funkci mají vlastnosti těchto vyjadřovacích prostředků, kterými jsou 

rastr, barva a písmo. Tyto vlastnosti jsou součástí mapového jazyka a 

poskytují nám další možnosti rozlišení. 

2.4.1 Rastr 

Rastry umožňují vyjádření 

kvantitativních i kvalitativních 

charakteristik plošných jevů. 

Mohou být realizovány díky 

pravidelně nebo nepravidelně 

uspořádaným bodovým nebo 

liniovým kartografickým 

znakům.  

Rastr má čtyři grafické 

proměnné – strukturu, směr, 

tloušťku/velikost a hustotu.  

Vzájemnou kombinací těchto parametrů vznikají rastry různých intenzit. 

Zejména zvětšováním tloušťky a hustoty rastru narůstá jeho intenzita, čímž 

můžeme zobrazit vyšší hodnotu znázorňovaného jevu. [8, 10] 

Struktura a směr rastru se používá pro znázornění kvalitativních dat (vlevo), 

zatímco pro kvantitativní data se používá tloušťka/velikost a hustota (vpravo). 

 
Obrázek 18 - Znázornění kvalitativních dat 

 

 
Obrázek 19 - Znázornění kvantitativních 

dat 

 

Obrázek 17 - Parametry rastru 
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2.4.2 Barva 

Barva je přirozenou podporou při orientaci v prostoru i v informacích. Je tedy 

zřejmé, že její úloha v kartografii, zvláště pak v tematické kartografii, je velmi 

důležitá. Barva v mapě může být samostatným vyjadřovacím prostředkem a 

zároveň je součástí většiny ostatních vyjadřovacích prostředků. Zároveň má 

významný vliv na celkové estetické působení mapového díla a jeho 

přehlednost, názornost a čitelnost. [10] 

Podle Terminologického slovníku zeměměřictví a katastru nemovitostí je barva 

vjemem, který je vytvářen viditelným světlem dopadajícím na sítnici lidského 

oka a z ní je pak převáděn pomocí receptorů (čípků a tyčinek) do lidského 

mozku. [16] Lidské oko je schopné rozlišit až 17 tisíc odstínů spektrálních 

barev a dalších asi 300 odstínů šedi. Z hlediska fyziky je viditelné světlo 

definováno vlnovou délkou v rozmezí 390 – 780 nm. [17] Kde nejkratším 

vlnovým délkám odpovídá fialová barva a dále pokračuje přes modrou, 

zelenou, žlutou a oranžovou až k nejdelším viditelným vlnovým délkám, které 

představují barvu červenou.  

 

Obrázek 20 - Spektrum viditelného světla dle vlnových délek λ [nm] 

Každá barva viditelného spektra je charakterizována třemi základními 

parametry, a to: tónem, světlostí a sytostí. 

Tón je vlastnost barvy daná vlnovou délkou. Je označovaná názvem barvy 

(např. žlutá, modrá). Tón barvy se udává polohou na standardním barevném 

kruhu (0° až 360°). Tón barvy slouží zejména ke znázorňování kvalitativních 

charakteristik, přičemž často bývá využívána asociativnost barev (např. 

modrá barva pro vodní plochu). 

Světlost nebo také jas je určen podílem světla v barevném tónu. Čím více 

světla barva obsahuje, tím je světlejší. Světlost se obvykle udává v procentech 

(100% jas odpovídá čisté barvě, 0 % je černá barva). 

Sytost barvy vyjadřuje podíl pestré barvy a barvy nepestré ve výsledném 

odstínu. Čím více pestré složky barva obsahuje, tím je sytější, čím méně pestré 

složky barva obsahuje, tím je více bledá. Sytost se obvykle udává v procentech 

(100% sytost označuje čistou barvu a 0 % je odstínem šedé). Sytost barvy se 

používá ke znázorňování kvantitativních charakteristik (s rostoucí hodnotou 

jevu vzrůstá sytost barvy). 

Kromě těchto základních parametrů lze barvy také definovat barevnými 

modely, tedy principem jejich vzájemného vztahu a průběhu mísení. Existuje 
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mnoho barevných modelů, které se mimo jiné dělí na modely fyzikálně – 

technické a modely vytvořené na základě vnímání. Dva základní způsoby 

míchání barev podle fyzikálně technických parametrů jsou:  

Aditivní neboli sčítací způsob, kde překrýváním barev 

vzniká světlo větší intenzity. Používá se při míchání 

barevných světel, například promítání projektorem nebo 

zobrazení barev na barevném monitoru. Model RGB (Red 

= červená, Green = zelená a Blue = modrá).  

A subtraktivní neboli odečítací způsob, kde s každou další 

přidanou barvou ubývá původního světla. Používá se při 

míchání pigmentových barev, například tisk na inkoustové 

tiskárně. Model CMYK (Cyan = azurová, Magenta = 

purpurová, Yellow = žlutá a Key po dotisk černou barvou). 

Nejpoužívanějším modelem vytvořeným na základě běžného 

vnímání barev je model HSV nebo také HSB (Hue, Saturation, 

Value of Brightness). Založený na již zmíněných třech 

základních parametrech barvy – tónu barvy, sytosti barvy 

a hodnotě jasu). [10, 18, 19] 

  

Použití barev souvisí v podstatě se všemi kartografickými metodami, které 

používají barvu jako jeden ze svých atributů. Tedy nejen vyjádření 

kvalitativního zastoupení jevu pomocí barevných schémat, která vyjadřují 

pomocí různých barevných tónů různé jevy nebo jevy různých kvalit. Ale také 

k vyjádření kvantitativního zastoupení jevu pomocí barevných stupnic, které 

vyjadřují pomocí změny světlosti a sytosti různou intenzitu zobrazovaného 

jevu. Barevná schémata mohou být využita například jako výplň 

kartografických znaků, pro odlišení kvality i kvantity vyjadřovaného jevu. 

Barevné stupnice jsou také využívány v dalších metodách tematické 

kartografie, například spojité jevy v metodě izolinií mohou být vyjádřeny 

barevnou stupnicí prostřednictvím barevné výplně ploch mezi jednotlivými 

izoliniemi, tak vzniká tzv. barevná hypsometrie.  

Stupnice mohou být sekvenční a divergentní. Sekvenční stupnice znázorňují 

posloupné, zpravidla absolutní hodnoty (např. nadmořské výšky, 

nezaměstnanost), zatímco divergentní stupnice popisují rozbíhavá zejména 

relativní data (např. kladné a záporné teploty nebo rozdíly od průměru). 

Barevné stupnice bývají jednobarevné, případně obsahují přechod mezi 

<- Obrázek 22 - Grafické znázornění modelu HSV 

Obrázek 21 - Aditivní (nahoře) a substraktivní (dole) míchání barev -> 
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dvěma blízkými barvami. Pro dobrou vypovídající hodnotu je důležité vytvořit 

kvalitní stupnici. [9, 11, 14] 

Neméně důležitou disciplínou je působení barev, které má i v kartografii své 

místo. Člověk vnímá barvu nejen podle její fyzikální podstaty, ale také 

subjektivním fyziologickým pohledem a psychologickými zvyklostmi. Proto 

bývá v kartografii často využívána tzv. asociativnost barev, kdy barvy použité 

v mapě připomínají barvu zobrazovaného jevu nebo jeho vlastnost, například 

černá a hnědá barva pro černé a hnědé uhlí nebo červená a modrá barva pro 

teplé a studené mořské proudy. Studené a bledé barvy se obecně používají 

k vyjádření záporných jevů a nízkých hodnot, teplé a syté barvy pak pro 

kladné jevy a vysoké hodnoty. Bílá barva pak bývá použita pouze pro vyjádření 

místa, k němuž neexistují sledovaná data. Černá barva pak slouží zejména 

k popisu mapy. [14, 20] 

2.4.3 Písmo 

Prostřednictvím písma je realizován popis obsahu mapy a kompozičních 

prvků (názvu, legendy, tiráže a textových polí). Písma je tedy v mapě poměrně 

velké množství a snadno tak může dojít k nepřehlednosti a tzv. přeplnění 

mapy. Ideální grafické vyvážení kartografické kresby a popisné složky 

představuje nesnadný úkol při tvorbě mapy, správný výběr písma je proto 

velmi důležitý.  

Grafická podoba písma může sloužit při kvalitativním, ale i při kvantitativním 

rozlišení objektů a jevů v mapě. Například při popisu sídel se velikostí písma 

může vyjádřit počet obyvatel, sídlo dominantního významu může být 

zvýrazněno podtržením. Dodržuje se zásada, že významnější prvky se 

zobrazují graficky výraznějším popisem, než prvky méně významné. Popis 

různorodých obsahových prvků mapy by měl být esteticky sladěn, ale také by 

měl být v souladu s ostatním obsahem mapy. Jeden mapový list by neměl 

obsahovat více než dva druhy písma a pět různých velikostí. 

Písmo je definováno čtyřmi základními parametry – rodem, řezem, velikostí a 

barvou.  

Rod písma, někdy také rodina, je určen jménem, souborem znaků a definicí 

tvaru. Nejznámějšími jmény jsou: grotesk – tzv. bezpatkové písmo tvořené 

jednoduchými stejně silnými písmovými tahy, antikva – tzv. patkové písmo je 

Obrázek 23 - Barevné stupnice jednobarevné (A), vícebarevné (B), divergentní (C) a 

barevná schémata (D) 
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tvořeno stínovanými písmovými tahy a je zakončované serifem neboli patkou. 

V kartografii pak méně používanými jmény jsou například medival nebo 

egyptek.   

Řez písma je určen tvarovými prvky kresby, tedy tloušťkou tahu tzv. duktus, 

sklonem a šířkou. Tloušťka udává, jestli je písmo slabé, normální, půltučné, 

nebo tučné. Sklon definuje písmo stojaté a skloněné tzv. kurzíva. Šířka písma 

se určuje ve směru řádku a obsahuje i prázdný prostor před a za písmenem, 

písmo tak může být zúžené, normální nebo široké. 

Velikost písma je udávána v typografických bodech (1 bod = 0,376 mm). 

Nejmenší písmo by mělo být vysoké alespoň 7 typografických bodů a rozdíl 

mezi dvěma popisy by měl být minimálně 2 typografické body. 

Barva písma se volí asociativně ve vztahu k popisovanému prvku, například 

popis řeky modrou barvou. [9, 10] 
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3 Použitá data a nástroje 

Pro tento mapový soubor byl zvolen souřadnicový systém S-JTSK, který byl 

navržen přímo pro území ČR a je také nejpoužívanějším souřadnicovým 

systémem v české kartografii. Všechna použitá data byla tedy v tomto 

souřadnicovém systému již pořízena nebo do něj později transformována 

pomocí nástrojů ArcMap. 

3.1 Podklady použitých map 

Mou prvotní představou bylo sehnat podkladová data od Českého úřadu 

zeměměřického a katastrálního (Data200, ZM50, ZABAGED, aj.), který má 

tato data ve své správě. Tato data však nejsou veřejnosti volně dostupná a 

ČUZK je poskytuje pouze za úplatu nebo pro zpracování studentských prací 

v omezené míře zdarma. Protože ale mým záměrem je tuto práci v rozšířené 

podobě dále prezentovat formou veřejné výstavy, nezdá se vhodné tato data 

využít. Snažila jsem se tedy získat tato data od města Benešov, které je má 

také k dispozici. Konkrétně jsem kontaktovala úřad územního plánování, 

odbor výstavby a územního plánování, správce geografických informačních 

systémů a městského architekta. Nikdo z nich mi však data neposkytl, byla 

jsem proto nucena postavit svou práci na vektorové databázi ArcČR 500 a 

datech OpenStreetMap. Tyto podklady však nebyly pro mou práci dostačující 

a proto jsem musela velkou část dat ručně vektorizovat z rastrových a jiných 

podkladů.  

V této kapitole jsou podrobně popsány zdroje, ze kterých jsem čerpala 

podkladová data pro vytvořené mapy. 

3.1.1 ArcData Praha 

ArcČR 500 je digitální vektorová geografická databáze, která vznikla ve 

spolupráci ArcData Praha, s.r.o. se Zeměměřickým úřadem. ArcData Praha je 

dodavatel řešení specializovaných na správu, analýzu a vizuální reprezentaci 

prostorových dat. ArcČR 500 zobrazuje Českou republiku na úrovni 

podrobnosti 1:500 000. Výchozím souřadnicovým systémem vektorové 

databáze ArcČR 500 je systém S-JTSK. Podkladem pro verzi 3.3 této digitální 

databáze byla data z roku 2016 poskytnutá Zeměměřickým úřadem (DATA 

200) a data z Českého statistického úřadu. [21] 

Tato databáze je volně ke stažení na stránkách ArcData Praha. 

Obsahem této databáze jsou přehledné geografické informace, které jsou 

rozděleny do dvou tematických skupin: administrativní členění ČR a základní 

mapové prvky. Pro tuto práci bylo využito právě administrativního členění 

České republiky na obce, okresy a kraje a upravená vrstva železnice.  
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3.1.2 Geofabrik.de 

OpenStreetMap je projekt s koncepcí Otevřeného software, jehož cílem je 

shromažďovat geografická data a dále je volně poskytovat. Umožňuje 

jednoduchou editaci dat a uchovává historii provedených změn, veškeré 

výsledky jsou dostupné veřejnosti. Údaje jsou shromažďovány především 

dobrovolníky pomocí zařízení GPS a přenášeny do centrální databáze s editory 

speciálně vyvinutými pro OpenStreetMap. Pro některé oblasti byla data 

importována z jiných zdrojů. Referenčním souřadnicovým systém je WGS 84. 

[22] 

Webová stránka Geofabrik Downloads poskytuje stahování dat 

OpenStreetMap z roku 2017 zdarma pro celé kontinenty nebo pro jednotlivé 

státy včetně České republiky. 

OpenStreetMap se zaměřuje především na dopravní infrastrukturu – dálnice, 

silnice a železnice. Ale obsahuje také prvky sídel, řek, budov a zájmových bodů 

nebo informace o využívání půdy. Pro tuto práci byly využity redukované 

vrstvy silnic a sídel.  

3.1.3 ČUZK 

Data RUIAN – veřejný dálkový přístup k datům registru územní identifikace, 

adres a nemovitostí byl dalším zdrojem dat pro tuto práci. Veřejný dálkový 

přístup je pomocí počítačové sítě připojen do centrální databáze aktualizované 

z podkladů katastrálních pracovišť. Obsahuje tedy hranice parcel, vrstvy 

budov, a mnoho dalších informací. [23] Z veřejného dálkového přístupu ČUZK 

byly staženy soubory výměnného formátu katastru nemovitostí z konce 

loňského roku pro Benešov a přilehlá katastrální území. Z tohoto zdroje bylo 

použito mnoho dat do několika map, například vrstva budov pro mapu výšek 

budov nebo aktuální zástavbu.  

Ústřední archiv zeměměřictví a katastru - Císařské otisky map stabilního 

katastru pro samostatný mapový list pochází z Ústředního archivu 

zeměměřictví a katastru. Specializovaný archiv ÚAZK shromažďuje a 

zpřístupňuje veřejnosti výsledky geodetických a kartografických prací, které 

probíhaly v minulosti na území Čech, Moravy a Slezska. [24]   

Geoportál ČUZK poskytuje mnoho dalších prohlížecích služeb, které byly 

využívány při tvorbě map pro jejich průběžnou kontrolu, například základní 

mapy ČR nebo aktuální ortofoto. 

3.1.4 Český statistický úřad 

Český statistický úřad je ústředním orgánem státní správy České republiky. 

ČSÚ zajišťuje získávání, zpracování a zveřejňování statistických údajů, 

zpracovává analýzy a projekce demografického vývoje, sestavuje souhrnné 
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statistické charakteristiky vývoje národního hospodářství, provádí průzkumy, 

vytváří a spravuje statistické klasifikace, statistické číselníky a statistické 

registry a poskytuje z nich informace. Zajišťuje vzájemnou srovnatelnost 

statistických informací ve vnitrostátním i mezinárodním měřítku. [25] 

Zvláštním zdrojem statistických údajů je pak Sčítání lidu, domů a bytů, které 

se provádí jednou za 10 let. Toto sčítání patří k nejobsáhlejším statistickým 

průzkumům, jež přináší velké množství údajů o lidech, jejich domech a 

bytech, které nelze jiným postupem efektivně zjistit. Poslední sčítání bylo 

uskutečněno v březnu roku 2011. [26]  

Údaje zpracované českým statistickým úřadem jsou k nahlédnutí i stažení ve 

veřejné databázi Českého statistického úřadu. Z ČSU bylo použito mnoho 

statistických dat, například počty vzdělaných obyvatel v mapě vzdělanosti.  

3.1.5 Data z projektu Historický fotografický materiál1 

Císařské otisky map stabilního katastru – nejstaršími použitými daty jsou 

georeferencované rastry Povinných císařských otisků stabilního katastru z 

roku 1840. Mapy stabilního katastru vznikaly v letech 1826 – 1843. Jejich 

kopie („otisky“) byly pak zasílány k archivaci do Centrálního archivu 

pozemkového katastru ve Vídni. Jedná se o ručně kolorované mapy, na nichž 

jsou podle druhu barevně odlišené pozemky popsané parcelními čísly. Mapy 

stabilního katastru vznikaly pro každé katastrální území odděleně v měřítku 

1:2880. Pro použitá katastrální území Benešov, Konopiště, Jírovice a 

Václavice byly rastry císařských otisků georeferencovány jinými studenty 

ČVUT v rámci  projektu Národního památkového ústavu, programu 

aplikovaného výzkumu a vývoje národní a kulturní identity (NAKI). [27, 28] 

Státní mapa odvozená 1:5000 – dalším historickým zdrojem dat jsou 

georeferencované rastry, tentokrát však jde o rastry Státní mapy odvozené 

v měřítku 1:5000. Státní mapa odvozená byla původně určena pouze pro 

vnitřní potřebu státních orgánů a socialistických organizací, mapy byly 

vydávány od roku 1950, ale zveřejněny až po roce 1990. Polohopis těchto map 

je odvozen z katastrálních map a vykreslen černou linkou, budovy jsou 

znázorněny tečkou, druh pozemku/porostu značkou. Výškopis je odvozen 

z různých podkladů v závislosti na jejich kvalitě v mapovaném území, 

nejčastěji se jedná o Základní mapu 1:10 000, topografické mapy 1:10 000 a 

1:25 000, vrstevnice a výškové kóty jsou vykresleny hnědou barvou. Každý 

mapový list zobrazuje obdélník o výměře 5 km2. Pro tuto práci byly použity 

mapové listy z roku 1951 (BENE08, BENE09, BENE18, BENE19), 

                                        
1 Historický fotografický materiál – identifikace, dokumentace, interpretace, prezentace, 
aplikace, péče a ochrana v kontextu základních typů paměťových institucí je projekt 

vzniklý díky programu aplikovaného výzkumu a vývoje národní a kulturní identity (NAKI). 
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1952 (SEDL00, SEDL10, SEDL20) a z roku 1953 (BENE28, BENE29), které 

byly opět již georeferencovány v rámci projektu NAKI. [29, 30] 

Oba tyto historické zdroje byly využity pro tvorbu mapy zobrazující postupný 

vývoj zástavby města a jeho blízkého okolí. 

3.1.6 Ředitelství silnic a dálnic 

Celostátní sčítání dopravy – mapa poskytující informace o průměrných 

intenzitách automobilové dopravy na dálničních a silničních sítích České 

republiky v roce 2016 byla vytvořena Ředitelstvím silnic a dálnic ČR, odborem 

Silniční databanky, společně s Národním dopravním informačním centrem 

v rámci Celostátního sčítání dopravy v roce 2016. Intenzity dopravy na 

silnicích byly stanoveny z výsledků ručních průzkumů, podle charakteru 

provozu na komunikaci byly pak hodnoty dále zpřesněny a diferencovány. 

Výsledné hodnoty jsou ročními průměry denních intenzit dopravy ve vozidlech 

za 24 hodin. [31] 

3.1.7 Ministerstvo dopravy 

Bodová vrstva dopravních nehod – v aplikaci „Statistické vyhodnocení nehod 

v mapě“ jsou shromážděny a prezentovány informace ministerstva dopravy o 

dopravních nehodách. Tato aplikace je provozována na geoinformačním 

systému Ministerstva dopravy – Jednotné dopravní vektorové mapě. 

Statistické vyhodnocení nehod v mapě vzniklo za spolupráce Policie české 

republiky a Centra dopravního výzkumu. Na základě této aplikace vznikla 

bodová vrstva dopravních nehod z roku 2016. [32] 

3.1.8 Ministerstvo životního prostředí 

Bodová vrstva vzdělávacích zařízení – webová mapová služba CENIA obsahuje 

vrstvu škol a školských zařízení. CENIA je Česká informační agentura 

životního prostředí a zajišťuje provoz mapového serveru Geoportál veřejné 

správy, jehož provozovatelem je Ministerstvo životního prostředí České 

republiky. Na podkladu této vrstvy vznikla bodová vrstva vzdělávacích zařízení 

v mapě vzdělanosti. [33] 

Archivní ortofoto – mapová aplikace Kontaminovaná místa obsahující 

historické ortofoto vznikla v rámci projektu národní inventarizace 

kontaminovaných míst České informační agentury životního prostředí a také 

díky Fondu soudržnosti Evropské unie, která tento projekt z velké části 

financovala.  Tato mapová aplikace vznikla kvůli identifikaci, evidenci a 

hodnocení kontaminovaných a potenciálně kontaminovaných míst 

v současnosti ale i v historii. Historickým podkladem pro tuto mapu byly 

právě letecké snímky z roku 1950 z Výzkumného ústavu geodetického a 
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kartografického v Dobrušce. Mapová aplikace Kontaminovaná místa je 

dostupná z: http://kontaminace.cenia.cz. [34] 

3.1.9 Informační dopravní systém 

Jízdní řády vlaků – webovou aplikaci Informačního dopravního systému 

vytváří firma CHAPS spol. s.r.o., tato aplikace obsahuje veřejný internetový 

jízdní řád IDOS, který je provozován a inzertně zastoupen mediální skupinou 

MAFRA, a.s. IDOS je vyhledavač jízdních řádů veřejné drážní, autobusové i 

městské dopravy. IDOS kromě vyhledání dopravních spojení poskytuje 

doplňkové informace o jednotlivých spojích, o řazení vlaků, o případném 

zpoždění vybraných spojů a také kontextové odkazy pro rezervaci/zakoupení 

jízdních dokladů. Podle jízdních řádů vlaků národního dopravce Českých drah 

vyhledaných v této aplikaci byla vytvořena vrstva železniční dostupnosti pro 

mapový list s dopravní dostupností. [35] 

3.2 Software ArcGIS 

Tato diplomová práce byla zpracována v aplikaci ArcMap 10.3 programu 

ArcGIS for Desktop verze 10.3 od americké společnosti ESRI, největší světové 

organizace pro tvorbu software geografických informačních systémů.  

ArcGIS for Desktop obsahuje aplikaci ArcMap, v jejímž prostředí je možné 

zobrazovat geografická data, pracovat s nimi, editovat je, tvořit prostorové 

analýzy, a další operace díky propojení s dalšími aplikacemi. Mezi ně patří 

ArcCatalog, v němž je možné organizovat a spravovat data, ArcToolbox, jež 

obsahuje nástroje pro zpracování prostorových dat a další aplikace. ArcMap 

tak představuje komplexní nástroj pro tvorbu mapových kompozic včetně 

jejich konečné úpravy. 
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4 Zpracování souboru tematických map 

V této kapitole je popsán postup tvorby tematické mapy a obecný pracovní 

postup tvorby mapy v prostředí ArcMap 10.3. Níže popsané postupy při práci 

v prostředí ArcMap jsou obecnými znalostmi získanými v průběhu studia, 

nebo byly nastudovány pro potřebu této práce z webové stránky Cvičení z 

předmětu Základy geoinformatiky Pavla Švece [36] nebo z oficiálních stránek 

Help pro ArcGIS [37]. 

4.1 Koncepce souboru map 

Tematické mapy bývají většinou zobrazeny formou map ostrovních, které 

zachycují pouze zájmový územní celek, například kraj nebo stát a okolní 

oblasti zanedbávají. Mým záměrem však bylo zobrazit město Benešov 

v souvislostech s jeho blízkým i vzdálenějším okolím. Proto jsem se rozhodla 

mapy zobrazit formou souvislého výřezu. Při rozmístění kompozičních 

mapových prvků jsem však brala ohled na hranici Benešovského okresu i 

katastrálního území. 

Pro zobrazení bližšího i vzdálenějšího okolí města jsem zvolila jeden rozměr 

mapového listu 50 x 50 cm. Aby se na mapové listy vešel požadovaný obsah 

s městem Benešov ve svém středu, byla odvozena dvě zaokrouhlená mapová 

měřítka 1:10 000 a 1:100 000. 
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4.1.1 Mapová kompozice 

Pro obě měřítka byla dodržena stejná mapová kompozice. 

 

Obrázek 24 - Kompozice mapových listů 

4.2 Tvorba map v prostředí ArcMap 10.3 

V prostředí aplikace ArcMap jsou možné dva způsoby pohledu na mapu. Data 

View – režim pro zobrazení geografických dat, kde probíhá práce s vrstvami, 

analýzy dat a jejich vizualizace. Druhým pohledem je Layout View – režim pro 

zobrazení mapového výkresu, kde je možné pracovat s mapovým listem a 

mapovými prvky. Tato kapitola popisuje obecný postup tvorby mapového 

listu. 
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4.2.1 Vytvoření souboru 

Nový mapový dokument se vytvoří po kliknutí na menu File -> New. Poté se 

v menu View -> Data Frame Properties, v záložce Coordinate system zvolí 

souřadnicový systém a v záložce General, kolonce Unit se nastaví fyzikální 

jednotky pro celý projekt. Těmito jednotkami jsou pro celou moji práci metry. 

Souřadnicovým systémem je S-JTSK, Souřadnicový systém jednotné 

trigonometrické sítě katastrální je definován Křovákovým zobrazením. Jedná 

se o dvojité konformní kuželové zobrazení v obecné poloze, kde osa X směřuje 

k jihu a osa Y směřuje k západu. V software ArcGIS se používá souřadnicový 

systém S-JTSK_Krovak_East_North s převrácenými oběmi osami je označený 

EPSG kódem 5514. 

4.2.2 Připojení WMS serveru 

Některá data v této práci byla získána díky připojení WMS Serveru a následné 

ruční digitalizaci. Tento způsob je sice pracný a zdlouhavý, ale jinak nebylo 

možné určitá data získat. Ve zvláštních případech by bylo možné využít 

automatické digitalizace, ta by však vzhledem ke kvalitě podkladových dat 

nebyla dostatečně přesná.  

Připojení WMS serveru se provádí prostřednictvím menu File -> Add Data -> 

Add WMS Server, kde v kolonce URL se vyplní adresa příslušné WMS služby. 

Připojená služba se pak zobrazí nejen v mapovém okně, ale také uloží 

do ArcCatalogu, kde je možné ji vyhledat v záložce GIS Servers.  

Tímto způsobem byly připojeny georeferencované rastry CO a SMO5, data 

CENIA, ortofoto a mnoho dalších. 

4.2.3 Vytvoření nové vrstvy 

Nová vrstva se vytvoří přímo v ArcCatalog. Po kliknutí pravým tlačítkem myši 

na geodatabázi v níž má být nová vrstva vytvořena, je zvoleno menu New -> 

Feature Class, čímž se otevře další dialogové okno, v němž je nově vzniklé třídě 

prvků přiřazeno jméno a typ prvků vytvořené vrstvy. Pro tuto práci byly 

využity pouze tři z možných typů prvků, a to: bodové prvky (Point Features), 

liniové prvky (Line Features) a prvky plošné (Polygon Features). Dále je zde 

zvolen souřadnicový systém a minimální vzdálenost mezi jednotlivými prvky. 

V posledním kroku před dokončením tvorby nové vrstvy je možné vytvořit nové 

sloupce v budoucí atributové tabulce, včetně výběru datového typu (Short 

Integer, Long Integer, Float, Double, Text a další). Po kliknutí na tlačítko Finish, 

vznikne nová vrstva. 

Novou vrstvu lze také vytvořit výběrem prvků z již existující vrstvy a to v Table 

Of Contents, kliknutím pravého tlačítka myši na vrstvu se zvoleným výběrem 

Selection -> Create Layer From Selected Features, čímž se nová vrstva 
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automaticky vykreslí, nevznikne však v její datová záloha v geodatabázi. Tu je 

potřeba dále vytvořit kliknutím pravého tlačítka na zobrazenou vrstvu v Table 

Of Contens -> Data -> Export Data.  

4.2.4 Editace 

Nástroj úpravy dat se spustí z hlavního panelu nástrojů Edit -> Start Editting, 

potom je možné upravovat i vytvářet jednotlivé prvky nebo jejich atributy. 

Úpravy je možné provádět i hromadně pomocí funkce Field Calculator. Avšak 

vytváření a odstraňování celých sloupců v atributové tabulce je možné, pouze 

pokud je editace ukončena.  

Nové prvky se vytváří v záložce Create Feature, kde se po zvolení editovaného 

prvku objeví nabídka nástrojů Construction Tools, v níž je pro liniové a plošné 

prvky možné zvolit nástroj pro kresbu linie/plochy – obdélníkem, kruhem, 

elipsou nebo volnou linií vedenou tahem kurzoru. V záložce Edit Sketch 

Properties lze upravovat jednotlivé body definující tvar vybraného prvku a 

upravovat hodnoty v atributové tabulce je možné buď právě v ní nebo 

v záložce Attributes. Každý prvek je zapsán v atributové tabulce, tedy tabulce 

vlastností jednotlivých prvků. Tyto vlastnosti pak slouží ke klasifikaci dat a 

k jejich následnému symbolickému vyjádření.  

4.2.5 Propojení dat 

Pro zpracování některých témat bylo nutné propojit statistická data 

v tabulkách s prostorovými daty v prostředí ArcGIS. K tomu bylo potřeba 

hodnotám v tabulce přiřadit nový sloupec s jedinečným propojovacím klíčem, 

tím byl nejčastěji kód základní územní jednotky pro obce i pro městské části 

hlavního města Prahy. Tabulka vytvořená v programu Excel byla pak 

importována do geodatabáze, v ArcCatalog pravým tlačítkem myši na cílovou 

geodatabázi Import -> Table to Table, kde byla požadovaná tabulka vybrána ze 

složky a tlačítkem OK potvrzeno její vložení. Poté byla tato tabulka připojena 

k vrstvě s územními celky, jejichž statistické hodnoty obsahovala. V poli Table 

Of Contents byla po kliknutí pravým tlačítkem myši na zvolenou vrstvu 

rozbalena kolonka Joins and Relates -> Join, čímž se otevřelo nové dialogové 

okno Join Data. V tomto okně byla definována připojovaná tabulka a 

odpovídající si sloupce v připojované tabulce a v atributové tabulce zvolené 

vrstvy, na jejichž základě mají být tabulky propojeny. 

4.2.6 Tvorba síťové analýzy 

Pro výpočet analýzy dostupnosti je potřebné zajistit, aby liniová vrstva, s níž 

chceme pracovat, neobsahovala topologické chyby. Což bylo v tomto případě 

zajištěno funkcí Planarize Lines, která je součástí nástroje Advanced Editing. 
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Tato funkce podle zadané tolerance propojí nedotažené linie a přetažené linie 

odstraní.  

Dále je nutné vypočítat pro jednotlivé liniové prvky hodnoty, podle nichž se 

bude určovat zjišťovaná dostupnost. V atributové tabulce byl proto vytvořen 

nový sloupec, do něhož byly vypočteny časy v minutách potřebné pro 

překonání daných liniových úseků. Tento čas byl vypočten podle následujícího 

vzorce:  

č𝑎𝑠 𝑣 𝑚𝑖𝑛𝑢𝑡á𝑐ℎ =
𝑑é𝑙𝑘𝑎 𝑑𝑎𝑛éℎ𝑜 𝑙𝑖𝑛𝑖𝑜𝑣éℎ𝑜 ú𝑠𝑒𝑘𝑢

(𝑝𝑟ů𝑚ě𝑟𝑛á 𝑟𝑦𝑐ℎ𝑙𝑜𝑠𝑡 ∙ 1000)/60
 

Poté už byl vytvořen nový soubor tříd prvků kliknutím pravého tlačítka myši 

na zvolenou geodatabázi -> New -> Faeture Dataset. Do tohoto souboru byla 

nahrána liniová vrstva silnic, nad níž má být vytvořena prostorová analýza, 

kliknutím pravého tlačítka na vytvořený Feature Dataset -> Import -> Feature 

Class. Potom nad souborem tříd je vytvořen síťový soubor opět kliknutím 

pravýého tlačítka na Feature Dataset -> New -> Network Dataset, kde v novém 

dialogovém okně je specifikován atribut pro výpočet analýzy, tedy sloupec 

vypočtených časů. Pro tento krok je potřebné mít zapnuté používání nástroje 

Network Analyst v menu Customize -> Extensions. Pro výpočet analýzy 

spádové oblasti je potřeba v  panelu Network Analyst vytvořit New Service 

Area. V dialogovém okně Service Area Properties, v záložce Analysis Settings 

byla nastavena impedance v minutách a rozhraní výpočtu požadovaných 

intervalů a v záložce Polygon Generation je zvolen typ vykreslení polygonů. Na 

závěr je vytvořen bod, k němuž se spádová oblast vypočítá Network Analyst -

> Create Network Location Tool a tlačítkem Solve je spuštěn automatický 

výpočet polygonů spádových oblastí. 

4.2.7 Vizualizace dat 

Data v prostředí ArcMap lze zobrazit různými způsoby díky nástrojům 

v nastavení vlastností vrstvy. Toto dialogové okno „Layer Properties“ se otevře 

po kliknutí pravým tlačítkem na konkrétní vrstvu a dále na nabídku 

Properties. Zde je několik záložek pro podrobné nastavení. General pro obecné 

vlastnosti vrstvy (název vrstvy, rozsahy měřítek pro zobrazení vrstvy), Source 

s určením rozsahu vrstvy a informacích o původů zobrazovaných prvků, 

Selection pro způsob označení vybraných prvků, Display pro způsob 

vykreslení dat (např. průhlednost), Symbology pro nastavení klasifikace a 

možnosti zobrazení klasifikovaných dat, Fields pro nastavení sloupců 

v atributové tabulce (jejich popisů, datových typů a jejich vzájemné 

uspořádání), Definition Query pro tvorbu definičních dotazů (pro vytváření 

podmnožin prvků), Label pro generování popisů (včetně pravidel jejich 

vykreslování), Joins & Relates pro spojení a relace s jinými vrstvami nebo 
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tabulkami, Time pro nastavení času jednotlivých vrstev (pro zobrazení jevu s 

vývojem v čase), HTML Popup pro tvorbu a nastavení vyskakovacích oken. 

Zásadní pro klasifikaci dat v této práci byla záložka Symbology, která je dále 

popsána podrobněji. Konkrétní možnosti klasifikace dat jsou v levém sloupci 

dialogového okna označeného popisem „Show“. 

Tabulka 1 - Metody klasifikace dat v programu ArcMap 10.3 

Features Single symbol 
vykreslí všechny prvky pomocí stejného 

symbolu 

Categories 

Unique values 
vykreslí kategorie pomocí jedinečných 

hodnot pro vybraný sloupec 

Uniqe values, many 

fields 

vykreslí kategorie podle jedinečných 

hodnot pro kombinaci vybraných 

sloupců (max. 3) 

Match to symbols 

in a style 

vykreslí kategorie podle hodnot 

odpovídajících symbolů z referenčního 

souboru znaků 

Quantities 

Graduated colors 
vykreslí kvantitu pomocí barevné 

stupnice podle intervalů hodnot 

Graduated symbols 

vykreslí kvantitu pomocí velikosti 

symbolů odpovídající relativním 

intervalům hodnot 

Proportional symbols 

vykreslí kvantitu pomocí velikosti 

symbolů odpovídající přesným 

hodnotám 

Charts 

Pie 
vykreslí koláčový diagram z více prvků 

pro každý územní celek 

Bar/Column 
vykreslí tabulku nebo sloupcový graf 

z více prvků pro každý územní celek  

Stacked 
vykreslí skládaný graf z více prvků pro 

každý územní celek 

Multiple 

Attributes 
Quantity by category 

vykreslí kategorie pro různé kombinace 

kvality i kvantity vybraných prvků 

 

Při vykreslování kvantity jevů pomocí barevných stupnic nebo velikostí 

symbolů je důležitá volba intervalů zobrazovaných dat. Toto rozdělení se 

určuje v poli Classification pod tlačítkem Classify. Po jeho rozkliknutí se 

otevře nové dialogové okno, v němž je možné zvolit počet intervalů, různé 

způsoby jejich automatického rozdělení nebo vlastní rozdělení. Metodu 

ručního rozdělení intervalů obsahuje volba Manual. Její výhodou je možnost 

nastavení hraničních hodnot intervalů na celá zaokrouhlená čísla, což je 

vhodné zejména pro pozdější vyhotovené legendy, které by neurčitá čísla 
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obsahovat neměly. Automatickými metodami jsou Equal Interval – rozdělení 

dat na daný počet stejně velkých intervalů, Defined Interval – rozdělení dat do 

stejně velkých intervalů (dána je velikost jednoho intervalu), Quantile – 

rozdělení dat do stejně obsáhlých intervalů (z hlediska počtu prvků), Natural 

Break (Jenks) – metoda přirozených zlomů sdružuje v intervalech podobné 

hodnoty a rozdíly mezi intervaly zdůrazňuje, Geometrical Interval – vytváří 

geometrické intervaly minimalizací součtu čtverců dat v každém intervalu 

(intervaly mají přibližně stejný počet hodnot a přechod mezi intervaly je 

poměrně plynulý) a poslední metoda Standard Deviation – která vytváří 

intervaly skrze výpočet odlišnosti hodnot od průměru pomocí směrodatné 

odchylky.  

Při klasifikaci dat v této práci, jsem většinou použila metody Quantile nebo 

Natural Breaks s ruční úpravou výsledných intervalů metodou Manual na 

zaokrouhlené hodnoty. Konkrétní barevné stupnice jsem vytvořila na základě 

webové aplikace Sequential Color Scheme Generator 1.0, která generuje 

kvantitativní barevné stupnice pro využití v mapách. Tato aplikace je 

dostupná na webových stránkách http://eyetracking.upol.cz/color/. A na 

základě vlastního uvážení podle předtištěné palety barev CMYK. 

4.2.8 Popis 

Popis prvků mapy je potřeba nejprve vygenerovat v záložce Layer properties, 

kde jsou nastaveny vlastnosti vykresleného písma a poté je popis převeden 

z dynamické podoby do geodatabáze jako třída prvků typu Annotation 

kliknutím pravého tlačítka myši na danou vrstvu a dále Convert Labels To 

Annotation. Následně byly popisy ručně upraveny a umístěny do vhodných 

pozic vzhledem k popisovaným prvkům i okolní kresbě. Popisy na všech 

mapových listech jsou vykresleny stejným písmem Roboto Light. 

4.2.9 Konečná úprava mapového listu 

Konečná úprava mapy probíhá v prostředí Layout view. Nejprve byl v menu 

File -> Page and Print Setup nastaven rozměr mapového listu 50 x 50 cm a 

v dialogovém okně Data Frame Properties v záložce Size and Position rozměr 

zobrazeného území na 48 x 48 cm, aby vznikl mapovému listu centimetr 

široký okraj. 

Poté byly vloženy jednotlivé kompoziční prvky. Název, měřítko, tiráž a legenda. 

Vše v menu Insert -> Title/ScaleBar/Text/Legend dále byly nastaveny jejich 

parametry, parametry jejich popisu a ručně upraveny do finální podoby.  

Posledním krokem bylo exportování mapy File –> Export map. Mapa byla 

exportována do formátu PDF v rozlišení 300 DPI, barevném provedení CMYK. 

Mapové listy s Císařskými otisky a ortofotem byly exportovány v rozlišení 250 

DPI, aby bylo možné je nahrát do školního informačního systému KOS. 
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5 Mapové listy 

V následující kapitole je konkrétně popsáno, jak byly vytvořeny jednotlivé 

mapové listy a jaká data obsahují. 

5.1 Město Benešov 

Na mapových listech v měřítku 1:10 000 je vyobrazeno město Benešov a jeho 

blízké okolí. Na západ od města se nachází zámek Konopiště, jižně od města 

pak statek Mariánovice a severně Pomněnický statek.  

5.1.1 Vývoj zástavby 

Vývoj zástavby je vyobrazen na třech samostatných mapových listech pro tři 

různá období. Podkladem pro nejstarší zaznamenaný stav jsou Císařské 

otisky map stabilního katastru z roku 1840. Dalším zmapovaným obdobím je 

polovina dvacátého století, konkrétně roky 1951 – 1953. Tímto podkladem 

byla Státní mapa odvozená 1:5 000. Poslední z těchto map zobrazuje aktuální 

stav z roku 2017. Na mapových listech jsou vždy tři základní kategorie, které 

informují o stavu budov, komunikací a vodstva v daných obdobích. Historické 

podklady byly ručně vektorizovány, aktuální data byla převzata z Registru 

územní identifikace, adres a nemovitostí a z OpenStreetMap. 

Tabulka 2 - Vrstvy mapového listu Vývoj zástavby 1840 

Vrstva Typ vrstvy Podkladová data Zdroj dat Datum 

budovy polygon CO stab. Katastru Hist. foto. materiál 1840 

silnice a cesty linie CO stab. Katastru Hist. foto. materiál 1840 

vodní plochy polygon CO stab. Katastru Hist. foto. materiál 1840 

potoky linie CO stab. Katastru Hist. foto. materiál 1840 

 

Tabulka 3 - Vrstvy mapového listu Vývoj zástavby 1951 - 1953 

Vrstva Typ vrstvy Podkladová data Zdroj dat Datum 

budovy polygon SMO5 Hist. foto. materiál 1951 - 1953 

silnice a cesty linie SMO5 Hist. foto. materiál 1952 - 1953 

vodní plochy polygon SMO5 Hist. foto. materiál 1953 - 1953 

potoky linie SMO5 Hist. foto. materiál 1954 - 1953 

 

Tabulka 4 - Vrstvy mapového listu Vývoj zástavby 2017 

Vrstva Typ vrstvy Podkladová data Zdroj dat Datum 

budovy polygon RUIAN VDP ČUZK 2017 

silnice a cesty linie OpenStreetMap Geofabrik 2017 

vodní plochy polygon OpenStreetMap Geofabrik 2017 

potoky linie OpenStreetMap Geofabrik 2017 
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Ke každému z mapových listů je připojen původní obraz mapovaného území. 

Pro devatenácté století jsou to právě císařské otisky map stabilního katastru 

z roku 1840, pro dvacáté století je to historické ortofoto z roku 1950 a pro 

jedenadvacáté století je to aktuální ortofoto z roku 2017. 

Na těchto mapových listech lze pozorovat proměnu města Benešov i jeho 

blízkého okolí, v historii výstavbu železniční tratě (koncem 19. stol.), která 

přetnula původní cesty, a vynutila si stavbu mostů, v této době došlo i 

k vystěhování průmyslových podniků z Konopiště do Benešova. V dnešní době 

Benešov obklopuje velké množství malých rodinných domků, které jsou na 

západní straně města značně zadrženy silnicí 1. třídy z Prahy do Tábora. 

Obecně se zástavba Benešova velmi rozrostla. 

5.1.2 Výšky budov 

Mapový list zobrazující výšky budov vznikl na podkladu dat Registru územní 

identifikace, adres a nemovitostí z katastrálních území: Benešov u Prahy, 

Chlístov u Benešova, Jírovice, Myslíč, Skalice u Benešova, Úročnice a 

Václavice u Benešova. Tato data však v atributech výšek budov obsahovala 

velké množství chyb, bylo proto nutné data opravit na základě vlastního 

šetření v terénu nebo na širokoúhlých snímcích „Panorama“ z mapového 

serveru Mapy.cz. 

Doplňující vrstvy silnic, železnice, řek a vodních ploch pochází z dat 

OpenStreetMap. Vrstva silnic je zde generalizována a dále graficky rozdělena 

do třech kategorií podle druhu vozovky na silnici 1. třídy, hlavní silnice a 

ostatní cesty a ulice.  

Tabulka 5 - Vrstvy mapového listu Výšky budov 

Vrstva Typ vrstvy Podkladová data Zdroj dat Datum 

budovy polygon RUIAN VDP ČUZK 2017 

železnice linie OpenStreetMap Geofabrik 2017 

silnice a cesty linie OpenStreetMap Geofabrik 2017 

potoky linie OpenStreetMap Geofabrik 2017 

vodní plochy polygon OpenStreetMap Geofabrik 2017 

 

Na mapovém listu zobrazujícím výšky benešovských budov můžeme dobře 

pozorovat vysoká sídliště v Nové Pražské a Na Bezděkově, nižší sídliště 

vzdálenější od centra města pak Na Spořilově, oproti nim pak dvou až 

třípatrovou zástavbu rodinných domků. Zvláště viditelné jsou také rozlehlé 

jednopodlažní haly při okrajích města. 
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5.1.3 Doprava 

Tento mapový list obsahuje informace z Celostátního sčítání dopravy 

Ředitelství silnic a dálnic o měření intenzity dopravy na významných 

komunikacích v podobě ročních průměrů projíždějících vozidel během 24 

hodin všedního dne. Intenzita dopravy je reprezentována liniovým diagramem. 

Dále mapový list obsahuje bodovou vrstvu dopravních nehod vytvořenou na 

základě Bodové vrstvy dopravních nehod Ministerstva dopravy ze stejného 

roku, kdy probíhalo měření intenzity, tedy z roku 2016. 

Tabulka 6 - Vrstvy mapového listu Doprava 

Vrstva Typ vrstvy Podkladová data Zdroj dat Datum 

intenzita dopravy linie 

Celostátní sčítání 

dopravy, OSM 

Ředitelství silnic a 

dálnic, Geofabrik 

2016, 

2017 

silnice a cesty linie OpenStreetMap Geofabrik 2017 

dopravní nehody bod Dopravní nehody Ministerstvo dopravy 2016 

vodní plochy polygon OpenStreetMap Geofabrik 2017 

potoky linie OpenStreetMap Geofabrik 2017 

 

Dominantou tohoto mapového listu je nejvyužívanější silnice E55, po které 

denně projede od Prahy na Tábor nebo opačným směrem až 25 000 vozidel. 

Tu pak následují svou výrazností hlavní průjezdy městem od E55 na Vlašim. 

Dále lze vyčíst z bodové vrstvy dopravních nehod velkou koncentraci srážek 

se zaparkovanými vozidly v centru města a na městských parkovištích nebo 

srážky s lesní zvěří v Konopišti a U Želetinky. 
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5.2 Okres Benešov 

Na mapových listech v měřítku 1:100 000 je zachyceno širší okolí města 

Benešov. Mapové listy zobrazují hranice okresů, na severu mapového listu je 

město Říčany, na jihu Miličín.  

5.2.1 Využití ploch 

Využití ploch je na tomto mapovém listu vyjádřeno pomocí strukturních 

diagramů. Informace o zemědělské i nezemědělské půdě pochází z Veřejné 

databáze Českého statistického úřadu.  

Tabulka 7 - Vrstvy mapového listu Využití ploch 

Vrstva Typ vrstvy Podkladová data Zdroj dat Datum 

využití ploch plocha - diagram 

Plocha území, 

ArcČR 500 

VDB ČUZK, 

ArcData Praha 2017 

hranice okresů linie ArcČR 500 ArcData Praha 2017 

 

Na tomto mapovém listu je pozorovatelé velké zastoupení orné půdy doplněné 

zástavbou takřka bez lesů v blízkosti Prahy. Na Sedlčansku a Benešovsku 

jsou poměry orné půdy s lesními pozemky a trvalým travním porostem vcelku 

vyvážené. Zvláště viditelné jsou také rozsáhlé lesy v Posázaví a v okolí 

Ondřejova nebo zastoupení vodních ploch v oblasti Slapské a Stěchovické 

přehrady. 

5.2.2 Obyvatelstvo 

Tento mapový list zobrazuje hustotu obyvatelstva v obcích, přepočtenou 

na 1 km2 metodou kartogramu. Počty obyvatel v jednotlivých obcích pocházejí 

z Veřejné databáze Českého statistického úřadu. Dále je mapa doplněna 

bodovými znaky sídel, jejichž velikost vyjadřuje počet obyvatel v jednotlivých 

sídlech. Pro vhodnou čitelnost a srozumitelnost mapy v měřítku 1:100 000 

byla bodová vrstva sídel generalizována, zobrazena jsou tak sídla obývaná více 

než 30 lidmi, protože menší vesnice a osady a jejich popisy by mapu přeplnily. 

Bodová vrstva pochází z OpenStreetMap. 

Tabulka 8 - Vrstvy mapového listu Obyvatelstvo 

Vrstva Typ vrstvy Podkladová data Zdroj dat Datum 

hustota zalidnění plocha 

Počet obyvatel, 

ArcČR 500 

ČSU, 

ArcData Praha 2017 

sídla bod OpenStreetMap Geofabrik 2017 

hranice okresů linie ArcČR 500 ArcData Praha 2017 
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Rozložení obyvatelstva vypovídá o klesajícím osídlení s rostoucí vzdáleností od 

hlavního města Prahy vyzdvižené většími městy jako je právě Benešov, Vlašim, 

Sedlčany, Votice nebo Sázava. Ukazuje se zde také, že obce v blízkosti 

hlavních dopravních tahů jsou obecně více zalidněné. 

5.2.3 Vzdělanost 

Tento mapový list obsahuje strukturní diagramy zobrazující procentuální 

vzdělanost obyvatelstva v obcích, zároveň svou velikostí popisuje počet 

obyvatel starších čtrnácti let žijících v dané obci. Tato data pochází ze Sčítání 

lidu, domů a bytů z roku 2011. Kromě toho obsahuje tento mapový list 

bodovou vrstvu vzdělávacích zařízení – mateřských, základních a středních 

škol, jednu vyšší odbornou školu a základní umělecké školy. Vysoké školy se 

v zobrazované oblasti nenacházejí. Tato vrstva vznikla na podkladu webové 

mapové služby České informační agentury. 

Tabulka 9 - Vrstvy mapového listu Vzdělanost 

Vrstva Typ vrstvy Podkladová data Zdroj dat Datum 

vzdělanost plocha - diagram 

SLDB 2011, 

ArcČR 500 

ČSU, 

ArcData Praha 

2011, 

2017 

školy bod CENIA Ministerstvo vnitra 2017 

hranice okresů linie ArcČR 500 ArcData Praha 2017 

 

Na mapě vzdělanosti je podobně jako na mapě osídlení znatelný vliv hlavního 

města Prahy, v jehož blízkosti je počet více vzdělaných obyvatel větší. Také 

v blízkosti hlavních dopravních drah a v menších spádových městech je tento 

jev evidentní. 

5.2.4 Pohyb obyvatelstva 

Na tomto mapovém listu je pomocí složených sloupcových grafů zobrazen 

pohyb obyvatel denně vyjíždějících z obcí za prací a vzděláním ve srovnání 

s lidmi, kteří za prací nebo vzděláním do téhož města denně dojíždějí. 

Podklady pro tuto analýzu pochází ze Sčítání lidu, domů, bytů 2011, Českého 

statistického úřadu. 

Tabulka 10 - Vrstvy mapového listu Pohyb obyvatelstva 

Vrstva Typ vrstvy Podkladová data Zdroj dat Datum 

dojíždějící 

plocha - 

graf 

SLDB 2011, ArcČR 

500 

ČSU, 

ArcData Praha 

2011, 

2017 

vyjíždějící 

plocha - 

graf 

SLDB 2011, ArcČR 

500 

ČSU, 

ArcData Praha 

2011, 

2017 

hranice okresů linie ArcČR 500 ArcData Praha 2017 
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Z pohybu obyvatelstva je pozorovatelné, že z většiny obcí lidé více vyjíždějí, než 

dojíždějí, a to hlavně studenti, kteří dojíždějí pouze do měst vybavených 

školou, ne jinam. Benešov je v této statistice výjimečně vyvážený, protože do 

něj dojíždí velké množství obyvatel z menších i větších okolních obcí a zároveň 

z něho mnoho lidí vyjíždí ven, většinou do hlavního města Prahy. 

5.2.5 Podíl vyjíždějících obyvatel 

Mapový list obsahuje strukturní diagramy přiřazené k jednotlivým obcím. 

Diagramy svou velikostí popisují počet obyvatel v obci starších pěti let, z nichž 

zvýrazněná část studentů/pracujících vyjíždí denně z dané obce. 

Tabulka 11 - Vrstvy mapového listu Podíl vyjíždějících obyvatel 

Vrstva Typ vrstvy Podkladová data Zdroj dat Datum 

podíl vyjíždějících 

obyvatel plocha - diagram 

SLDB 2011, 

ArcČR 500 

ČSU, 

ArcData Praha 

2011, 

2017 

hranice okresů linie ArcČR 500 ArcData Praha 2017 

 

Oproti předcházející mapě tato vystihuje poměr obyvatel, kteří z obcí denně 

vyjíždějí vzhledem k těm, kteří v něm zůstávají.  

5.2.6 Dopravní dostupnost 

Tento mapový list zobrazuje dopravní dostupnost města Benešov a to dvojím 

způsobem. Žluté plochy znázorňují svou sytostí silniční dostupnost 

vypočtenou v programu ArcGIS nástrojem Network Analyst nad silniční sítí 

OpenStreetMap. Pro jednotlivé úseky byl dle průměrné rychlosti vypočten čas 

k jejich překonání a dále byl pro tvorbu této vrstvy dodržen postup popsaný 

v odstavci 4.2.6 Tvorba síťové analýzy. Výpočetní bod dostupnosti byl umístěn 

do centra města Benešov. Modré linie pak reprezentují železnici, kde sytost 

barvy odpovídá potřebnému času pro překonání dané vzdálenosti dle jízdního 

řádu Českých drah. 

Tabulka 12 - Vrstvy mapového listu Dopravní dostupnost 

Vrstva Typ vrstvy Podkladová data Zdroj dat Datum 

silniční dostupnost plocha OpenStreetMap Geofabrik 2017 

železniční dostupnost linie 

Jízdní řád ČD, 

ArcČR 500 

IDOS, 

ArcData Praha 2017 

hranice okresů linie ArcČR 500 ArcData Praha 2017 

 

Poslední mapový list porovnává silniční dopravu s dopravou železniční. Na 

první pohled je zřejmé, že silniční síť velmi dobře pokrývá celé okolí města 

Benešov, zatímco železnice je v tomto ohledu velmi omezena. Na železniční síti 

samotné se projevuje rychlejší trasa z Prahy do Českých Budějovic a pomalejší 



- 50 - 

 

tratě jakou je například Posázavský Pacifik. Dále je z mapy čitelné protažení 

dojezdových oblastí v okolí rychlostní silnice E55 a dálnice D1. 
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6 Závěr 

Díky této diplomové práci bylo nashromážděno mnoho geografických, 

statistických i tematických dat týkajících se města Benešov a jeho okolí, data 

bylo následně nutné vhodně setřídit k dalšímu zpracování. Poměrně velká část 

dat však nebyla kompletní a bylo proto nutné provést podrobnou ruční editaci. 

Některé vrstvy byly upraveny na základě přímého pozorování v terénu. Dále 

byly z těchto dat pomocí jednoduchých i složitějších analýz v programu 

ArcGIS vytvořeny jednotlivé mapové listy tematického mapového souboru. 

Výstupem této práce je kromě souboru tematických map tento text obsahující 

stručnou historii města Benešov, kterého se tato práce neodmyslitelně týká. 

Ale také principy a postupy tvorby tematických map, které bylo potřeba 

připomenout a které není snadné vždy perfektně dodržet. Konkrétně tato 

textová část obsahuje popis mapové kompozice a kompozičních prvků, zásady 

tvorby tematických map, metody tematické kartografie a popis vlastností 

vyjadřovacích prostředků používaných v tematické kartografii. 

Součástí této práce je také praktický popis tvorby map v aplikaci ArcMAP 

programu ArcGIS for Desktop 10.3. 

Náročným úkolem při tvorbě této práce byla zdlouhavá vektorizace mnohých 

dat. Také oprava dat chybných nebo chybějících a to obzvlášť v případech 

statistik týkajících se různých obcí se stejným názvem, které vnášely do 

zpracování nepříjemný chaos. Proto muselo být veškeré zpracování velmi 

pečlivé. 

Město Benešov je bezpochyby svázáno s hlavním městem Prahou, je však 

zároveň poměrně samostatným městem s nezanedbatelnou vlastní spádovou 

oblastí pro menší okolní obce, ale také pro větší města ve svém okrese. Na 

mapě pohybu obyvatel je pozorovatelný fakt, že z Benešova denně vyjíždí a to 

většinou právě do hlavního města Prahy, na které je velmi dobře dopravně 

napojeno, téměř čtyři a půl tisíce obyvatel, což je více než čtvrtina. A zároveň 

do něj srovnatelné množství lidí z okolních obcí denně dojíždí, z nichž necelá 

třetina jsou studenti, což je patrné na mapě podílu vyjíždějících obyvatel. 

Vzdělanost benešovských obyvatel je v porovnání s ostatními ve svém blízkém 

okolí jen mírně nadprůměrná. Z mapy vzdělanosti je dále ale zřejmá 

vzrůstající vzdělanost v okolí hlavních tras na Prahu, v blízkosti Prahy 

samotné a obecně ve větších městech. V ostatních ohledech je město Benešov 

vcelku průměrným.  

Záměrem této diplomové práce bylo shrnout pravidla a principy tematické 

kartografie a s pomocí těchto znalostí a znalostí nabytých v průběhu celého 

studia vytvořit soubor tematických map. Což bylo splněno.  
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Mým budoucím cílem je vytvořit z těchto map a dalších více či méně 

kartografických výstupů v příštím roce veřejnou výstavu ve městě Benešov. 

Vytvořený soubor tematických map tvoří samostatnou přílohu k této práci. 

Zároveň jsou vytvořené mapy v elektronické podobě na přiloženém CD. 
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